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Chapter 1: Introduction

This manual covers the setup, operation, and user maintenance of an LD Platform Cart Trans-
porter and cart.

The basic configuration performed using the software that comes with the system is covered.
Full details of that configuration are covered in the Mobile Robot Software Suite User’s Guide.

1.1 Definitions

Platform: The most basic part of the robot. It includes the chassis, drive assemblies, sus-
pension, wheels, battery, safety scanning laser, obstacle-avoidance lasers, sonar, an on-board
LD Platform core with built-in gyroscope, software needed to navigate, connectors for inter-
facing with and powering the Operator panel and cart coupling system, Operator panel, and
the platform covers.

LD Platform Cart Transporter: A platform with the LD Platform OEM (including extended
arms) and the coupling plate attached, set up to transport a cart. This is also referred to as just
a transporter.

Cart: A cart, on four casters, that can be attached to an LD Platform Cart Transporter, for
increasing the payload capacity. The cart has brakes on two casters, which can be released
either by coupling with a transporter, or by using a manual brake-release lever on the cart.

AIV (Autonomous Intelligent Vehicle): The LD Platform Cart Transporter with a cart attached
to it. This is the complete mobile robot, which will transport your payload on the cart.

For the initial setup, configuration, and connections, we will refer to the platform.

For controlling or monitoring the full mobile robot, with a cart attached, we will refer to the
AlV.

1.2 Product Description

The LD Platform Cart Transporter is a general-purpose mobile platform designed for moving a
detachable cart indoors and around people. It is self-guided and self-charging, with an auto-
mated docking station.

The platform, which moves the cart, comes complete with the ability to know where it is
within your workspace, and to navigate safely and autonomously to any accessible destination
within that workspace, continuously and without human intervention.

The LD Platform Cart Transporter is intended to expand the range of payloads that can be
moved by a platform, both in weight and size.

The LD Platform Cart Transporter is available in two models, designed to transport carts with
a payload up to 105 kg (231 1b) for the LD-105CT and 130 kg (287 1b) for the LD-130CT plat-
form. Where appropriate, differences between the models are called out. Otherwise, this
manual applies to both LD Platform Cart Transporters.
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1.2 Product Description

Figure 1-1. Cart and LD Platform Cart Transporter, Separate

Figure 1-2. Cart and LD Platform Cart Transporter, Coupled
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Figure 1-3. LD Platform Cart Transporter Model Labels

LD Platform Cart Transporter

The LD Platform Cart Transporter is a mobile platform, designed for working around people
while moving a cart. It is self-guided and self-charging, with an automated docking station.
The transporter combines hardware and mobile-robotics software to provide an intelligent,
mobile platform to transport your payload on the cart. Its primary guidance uses a safety scan-
ning laser to navigate, comparing the laser readings to a digital map stored on the platform.
The laser is backed up by a gyroscope mounted on the internal core, and encoders and Hall
sensors on each drive wheel.

In addition to the front safety scanning laser, each LD Platform Cart Transporter has two side
lasers, for detecting potential obstacles in its path, a low front laser in the bumper to detect
obstacles lower than the safety scanning laser, and a rear-facing obstacle-detection laser, to
ensure that it is safe for the transporter to back up or turn in place.

For situations that are so dynamic that laser localization becomes difficult, we offer the Acuity
Localization option, which localizes the AIV using an upward-facing camera to recognize over-
head lighting patterns. This would apply to areas where objects, such as pallets or carts, are
moved so frequently that they can’t be mapped, or where they block the laser’s view of fea-
tures that are mapped. This is covered in the LD Platform Peripherals Guide.

Body and Drive

The LD Platform Cart Transporter is relatively small, lightweight, and highly maneuverable. It
has a strong aluminum chassis and solid construction that makes it very durable.

The platform is a two-wheel, differential-drive vehicle, with spring-loaded passive casters front
and rear for balance. The drive-wheels have independent spring-suspension, with solid, foam-
filled tires. The wheels are at the mid-line of the platform, so that the platform can turn in
place.

Safety Scanning Laser

The onboard navigation laser is a very precise scanning sensor. The laser provides 500 read-
ings in a 240 degree field of view, with a typical maximum range of 15 m (49.2 ft). The laser

14766-000 Rev G LD Platform Cart Transporter User's Guide 13



1.2 Product Description

operates in a single plane, positioned at 200 mm (7.9 inches) above the floor. In most envir-
onments, the sensor will provide highly-accurate data.

Glass, mirrors, and other highly-reflective objects cannot be reliably detected by the laser. Cau-
tion must be exercised when operating the AIV in areas that have these types of objects. If the
AIV will need to drive in close proximity of these objects, we recommend that you use a com-
bination of markings on the objects, such as tape or painted strips, and also use forbidden sec-
tors in the map, so that the AIV knows to plan paths safely around these objects.

Side Lasers

These two lasers are used to detect obstacles that protrude into the AIV's path, but may not be
detected by the safety scanning laser.

This is needed when obstacles higher than the safety scanning laser (but low enough to be
obstacles) protrude into the AIV’s path.
Low Front Laser

This laser is mounted to the front bumper. It detects obstacles that are low and in front of the
transporter, such as an empty pallet, which might be too low for the safety scanning laser to
see.

Rear-Facing Laser
This laser gives better coverage of what's behind the transporter than sonar alone. It is used
during both turning in place and backing up when the transporter and cart are coupled.

Coupling Laser

A laser mounted in the transporter coupling plate is used to locate a triangle on the underside
of the cart’s coupling plate. This is used by the transporter to accurately align with the cart, so
it can couple with it.

Sonar

The LD Platform Cart Transporter’s two rear-facing sonar pairs are for obstacle-sensing while
backing up. The range is up to 5 m (16 ft), though the typical accurate range is only about 2 m
(10 ft). Each pair consists of one emitter and one receiver. The sonar emitters and receivers are
identical physically, but the transporter uses them differently.

Encoders and Gyroscope

Each wheel has an encoder that tells the navigation system how far the wheel has turned, and
in which direction. Each wheel also has a Hall sensor.

The LD Platform core has a gyroscope mounted on it, to track the AIV's rotation.

The combination of rotation and distance traveled are used by the platform to back up the
safety scanning laser during localization. These limit the area on the platform's map that the
AIV needs to search when localizing.

14 LD Platform Cart Transporter User's Guide 14766-000 Rev G



Chapter 1: Introduction

What’s Included with an LD Platform Cart Transporter

One fully-assembled platform

The platform includes a safety scanning laser, a low front laser, two side lasers, a rear-
facing laser, and two rear-facing sonar pairs. Each pair is one transmitter and one
receiver.

One battery
This is shipped separately from the platform, due to air shipping regulations.

If the battery was shipped by air, it will be at less than 30% charge per IATA reg-
ulations.

Top plate and coupling plate

The platform top plate covers the payload bay of the platform, and supports the lower
(platform) coupling plate, which engages the cart coupling plate, attached to the cart,
and the coupling laser.

LD Platform core, which includes an integrated computer, running Advanced Robotics
Automation Management (ARAM) and a microcontroller with MARC firmware. The
core is housed inside the platform. It also runs the SetNetGo OS.

ARAM and MARC firmware and the SetNetGo OS are pre-loaded on the LD Platform
Core.

An HMI Post

This supports the two side lasers and the rear-facing laser, both for obstacle avoidance.
It also supports the Operator Panel.

Operator Panel

This includes a touchscreen, an E-Stop button, ON and OFF buttons, a brake-release but-
ton, and a keyswitch, which can be locked, and key removed, in either position. The
panel’s frame supports two WiFi antennas and a beacon.

There are LATCH and UNLATCH buttons below the E-Stop.

The optional Acuity Localization camera mounts on top of the Operator panel frame, on
the same plane as the antennas and beacon.

Automated docking station

This allows the LD Platform to charge itself, without user intervention. It includes a
wall-mount bracket and a floor plate, for a choice of installation methods. See Installing
the Docking Station on page 49.

A manual charging cord is included, so you can charge a spare battery outside of the
platform.

Joystick (option)

This is used for manually controlling the AIV, mostly when making a scan to be used
for generating a map.

At least one joystick is needed for each fleet of AIVs. Once a map is generated, the map
can be shared with multiple AIVs working in the same space.
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1.2 Product Description

Cart

The cart is a frame mounted on four casters, designed so that it can couple with an LD Plat-
form Cart Transporter. Once coupled, the cart moves with the transporter. When the trans-
porter arrives at the intended goal, it uncouples from the cart and leaves, while the cart
remains at the goal. Brakes automatically engage on the cart casters, preventing it from rolling
in case the floor isn’t completely level.

The cart has a manual brake-release lever, so it can be moved manually.

Coupling

The LD Platform Cart Transporter can attach to a cart at a pickup goal, move the cart to a
dropoff goal, and leave it at that goal, with no human intervention.

When the cart and transporter are coupled, the transporter automatically presses a lever that
releases the cart’s brakes, so it is free to move with the transporter.

The coupling system has:

e a motorized Latching Mechanism

 a coupling laser

This is mounted in the coupling plate, and is used to align the transporter with the cart
when coupling.

o LATCH and UNLATCH override buttons, on the Operator Panel

Coupling Plates

Each cart has one coupling plate, and each platform has one coupling plate. The plates are
mounted so that, when the platform moves under the cart, the plates can attach to each other,
allowing the platform to move the cart. The software is aware of whether or not a cart is
attached.

o The cart coupling plate includes a slot that can be latched with the platform coupling
plate. The cart coupling plate is passive.

o The platform coupling plate includes a laser, for aligning the platform before coupling,
and a motorized Latching Mechanism, for latching the cart coupling plate.

Optional Components
Refer to Options on page 143 for details.
o Acuity Navigation

For environments that are very dynamic, such that a map can’t be kept current, or
where the area is too large for the navigation laser to see, Acuity can be used to nav-
igate using overhead light patterns seen with an upward-facing camera.

» Enterprise Manager

This system manages a fleet of AIVs, for multi-AIV traffic coordination and job man-
agement. It includes the Enterprise Manager appliance running the Mobile Software
suite.
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o Spare battery

A spare battery can be used to minimize down-time. Swapping the battery for a fully-
charged battery avoids taking the AIV out of service for more than a few minutes.

« Call/Door Boxes

These allow an AIV to be requested from a remote location, or allow the AIV system to
control an automated door, so the AIV can pass through it.

User-Supplied Components / System Requirements
PC with Microsoft Windows®

o Ethernet (wireless preferred)
Wireless is required for a fleet (more than one AIV).

» 100 megabytes of available hard-disk storage

1.3 Software Overview

Mobile Robot Software Suite

The Mobile Robot Software Suite includes all of the software used for platforms and the Enter-
prise Manager appliance, with the exception of the SetNetGo OS.

ARAM

The Advanced Robotics Automation Management software (ARAM) runs on the LD Platform
core. It operates ranging sensors like the safety scanning laser and sonar, and performs all the
high-level, autonomous robotics functions, including obstacle avoidance, path planning, loc-
alization, navigation, and so on, culminating in motion commands to the MARC firmware.
ARAM also controls the battery and light discs, and manages digital and analog /O, which,
along with platform power, provide for integration of application-specific sensors and effectors
that the user adds.

ARAM manages wired and wireless Ethernet communications with offboard software, for
external monitoring, development, and systems coordination, including coordination of a fleet
of AIVs through the optional Enterprise Manager . It also manages integration with other sys-
tems, as well as external monitoring, setup, and control with the MobilePlanner application.

ARAMCentral

ARAMCentral is the software that runs on the Enterprise Manager appliance. This software
and the appliance combined are referred to as Enterprise Manager.

For a fleet, the ARAMCentral software manages:
o the map that all AIVs use

o the configuration that all AIVs use

o traffic control of the AIVs

This includes multi-AIV avoidance, destination, standby, and dock control.

14766-000 Rev G LD Platform Cart Transporter User's Guide 17



1.3 Software Overview

e queuing of jobs for the AIVs

» remote I/O, if you are using it

MobilePlanner (licensed)

In order to have your AIV perform autonomous mobile activities, you need to make a map of
its operating space, and configure its operating parameters. The MobilePlanner software is
used to make this map and perform this configuration.

Refer to the separate Mobile Robot Software Suite User’s Guide for details on how to map a work-
ing space and prepare the virtual elements, goals, routes, and tasks for your application. In par-
ticular, refer to:

Working With Map Files > Editing a Map File > Using the Drawing Tools >
Adding Goals and Docks

The MobilePlanner software requires a license to run. You will need at least one license for
MobilePlanner for each fleet of AIVs. Once you generate a map for an area, it can be shared
between multiple AIVs in one fleet.

MobilePlanner, Operator Mode

The MobilePlanner Operator Mode is used to monitor one or more AlV's activities and have
them perform mobile tasks in the mapped space. When MobilePlanner is started without its
license dongle, it automatically starts in this mode. Refer to the separate Mobile Robot Software
Suite User’s Guide for details.

Mobile Adept Robot Controller (MARC)

At the lowest level, a microcontroller running MARC firmware handles the details of platform
mobility, including maintaining the platform’s drive speed and heading, as well as acquiring
sensor readings, such as from the encoders and gyroscope, and managing the platform’s emer-
gency stop systems, bumper, and joystick. The MARC firmware computes and reports the plat-
form’s odometry (X, Y, and heading) and a variety of other low-level operating conditions to
ARAM.

Touchscreen Support

Whenever the Mobile Software suite is downloaded, it includes support software for the
optional touchscreen.

Call/Door Box Support

Call/Door boxes have one software component on the box and another on either the Enterprise
Manager or on the single AIV, when there is no Enterprise Manager.

ARCL Protocol

ARCL is a function of ARAM and ARAMCentral, which is included as part of this suite.

The Advanced Robotics Command Language, or ARCL, is a simple text-based command and
response server for integrating an AIV (or fleet of AIVs) with an external automation system.

ARCL allows you to operate and monitor the AlV, its accessories, and its payload devices over
the network, with or without MobilePlanner.
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SetNetGo

The SetNetGo OS runs on the LD Platform core and Enterprise Manager appliance. It is the
host OS in which ARAM and ARAMCentral run.

The SetNetGo interface in the MobilePlanner software is used for configuring the Ethernet set-
tings for the platform, upgrading software, and performing systems diagnostics, such as
retrieving log files. It can be accessed when connected via the maintenance and management
Ethernet ports, or via wireless Ethernet if enabled.

NOTE: It is possible to connect directly to the SetNetGo OS on a platform
through a web browser. The main intent of this is to allow your IT support to set
up the network for you, without using MobilePlanner, which requires a license.

1.4 How Can I Get Help?

Refer to the corporate website:

http://www.ia.omron.com

Related Manuals

This manual covers the installation, setup, operation, and maintenance of an LD Platform Cart
Transporter. There are additional manuals that cover these actions for the platform.

Table 1-1. Related Manuals

Manual Title Description

Mobile Robot LD Safety Contains general safety information for all of our LD Platforms.

Guide

Mobile Robot Software Covers MobilePlanner software, the SetNetGo OS, and most of
Suite User's Guide the configuration of an LD Platform.

Enterprise Manager Covers the Enterprise Manager 1100 system, which is hardware
1100 User's Guide and software used for managing a fleet of AIVs.

LD Platform Peripherals | Covers peripherals, such as the Touchscreen, Call/Door box, and
Guide Acuity Localization options.

Support

If, after reading this manual, you are having problems with your LD Platform Cart Trans-
porter, contact your local Omron support.

o In the body of your e-mail message, provide your platform’s serial number and describe
the problem you are having in as much detail as possible.

» Attach your debuginfo file to the email. Refer to the next section for details on retrieving
your debuginfo file. See the following section for generating your debuginfo file.

Including a DebuglInfo File

If the platform has been set up on a wireless network, skip to SetNetGo Access on page 20.
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Network Setup

If the AIV has not been set up on a wireless network, a local area network will have to be set
up on a separate PC, and configured to talk to the AIV over a TCP/IP port. The IP address
should be set to: 1.2.3.5. The Subnet Mask should be 255.255.255.0.

(Windows 7) Start > Control Panel > (Network and Internet >) Network and Sharing Center
> Change adapter settings

(Windows 10) Start > Settings > Network and Internet > Change adapter options
Right-click on the LAN Connection, and click on Properties.

From the Properties dialog, scroll to and double-click the Internet Protocol (TCP/IP or
TCP/IPv4) option. In Internet Protocol Properties, click both “Use the following...” radio but-
tons to enable them, and then type in the IP and netmask values.

Connect the network port of your computer to the platform's Maintenance port. See the figure
Location of Parts in the Payload Bay on page 146.
SetNetGo Access

If the MobilePlanner software is available, use the SetNetGo interface within that software to
access SetNetGo. Otherwise, open a web browser and enter the URL: https://1.2.3.4:

You will be requested to confirm security certificates.
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Regardless of how you accessed SetNetGo, you should now have a window similar to the fol-
lowing;:

1. From the SetNetGo screen, select:
Status > Debug Info

This will display the “Download debug info” button.
2. Click Download debug info.

3. Save the downloaded file, and attach it to your support request.
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2.1 Dangers, Warnings, and Cautions

Alert Levels

There are three levels of alert notation used in our manuals. In descending order of import-
ance, they are:

DANGER: Identifies an imminently hazardous situation which, if not
avoided, is likely to result in serious injury, and might result in fatality or
severe property damage.

WARNING: Identifies a potentially hazardous situation which, if not avoided,
will result in minor or moderate injury, and might result in serious injury, fatal-
ity, or significant property damage.

CAUTION: Identifies a potentially hazardous situation which, if not avoided,
might result in minor injury, moderate injury, or property damage.

Alert Icons

The icon that starts each alert can be used to indicate the type of hazard. These will be used
with the appropriate signal word - Danger, Warning, or Caution - to indicate the severity of the
hazard. The text following the signal word will specify what the risk is, and how to avoid it.

Icon Meaning Icon Meaning
This is a generic alert icon. Any This identifies a hazardous entan-
specifics on the risk will be in glement situation.
the text following the signal
word.
This identifies a hazardous elec- This identifies a fire risk.

trical situation.

This identifies a hazardous This identifies a laser emitter eye
burn-related situation. damage situation.

D> B>
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Icon Meaning Icon Meaning

This identifies a hazardous ESD
situation.

Falling Hazards

WARNING: PERSONAL INJURY OR PROPERTY DAMAGE RISK
The AIV can cause serious injury to personnel or damage to itself or other
equipment if it drives off of a ledge, such as a loading dock, or down stairs.

Physical Barriers

The edge of a loading dock, the entrance to downward stairs, or any other substantial drop
that is within the AIV’s expected operating area should be physically marked so that the AIV’s
navigation laser will see the barrier, and stop before reaching it. The AIV is designed to detect
objects 200 mm tall, so the barrier must be at least that tall. However, because of variations in
floor flatness, we recommend a barrier that is 250 mm tall.

This needs to be continuous at the site, so that the AIV can’t drive around or through it to the
dropoff.
Special Information

There are several types of notation used to call out special information.

IMPORTANT: Information to ensure safe use of the product.
NOTE: Information for more effective use of the product.

Additional Information: Offers helpful tips, recommendations, and best prac-
tices.

Version Information: Information on differences in specifications for different
versions of hardware or software.

2.2 What to Do in an Emergency /Abnormal Situation

Press the E-Stop button (a red push-button on a yellow background) and then follow the
internal procedures of your company or organization for an emergency /abnormal situation. If
a fire occurs, use a type D extinguisher: foam, dry chemical, or CO,.

Releasing the Brakes

In case of an emergency or abnormal situation, the transporter can be manually moved.
However, only qualified personnel who have read and understood this manual and the Mobile
Robot LD Safety Guide should manually move the transporter. The brakes on the drive wheels
can be released with the brake release button. This requires battery power, and an E-Stop must
be pressed on the transporter.
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Version Information: The LD-130CT has a high gear ratio, and is difficult to
move, even with the brakes released.

Releasing an E-Stop

CAUTION: PERSONAL INJURY OR PROPERTY DAMAGE RISK
If the AIV’s E-Stop is triggered, ensure that the cause of the E-Stop is resolved,
and all surrounding areas are clear releasing the E-Stop.

After the E-Stop button has been manually released, the AIV will wait until the motors are
manually enabled.

There are two ways to enable the motors:

» Using MobilePlanner

 Pressing the green ON button on the Operator Panel or the GO button on the Touch-
screen

Once the motors are enabled, the transporter will wait two seconds and then resume com-
manded motion, if there is adequate space to maneuver.

2.3 Safety Precautions

WARNING: PERSONAL INJURY OR PROPERTY DAMAGE RISK
LD Platform robots can cause serious injury or death, or damage to itself and
other equipment, if the following safety precautions are not observed.

WARNING: ELECTROCUTION RISK
During maintenance, disconnect AC power from the robot, and install a lock-
out tag-out to prevent anyone from reconnecting power.

User's Responsibilities
It is the end-user’s responsibility to ensure that the AIVs are used safely. This includes:

» Reading the installation and operation instructions, as well as the Mobile Robot
LD Safety Guide, before using the equipment.

o Ensuring that the environment is suitable for safe operation of the AIV.

If a fleet of AIVs (two or more) is installed, the Enterprise Manager must be used, unless
no two AIVs will ever operate in the same area.

o Ensuring that anyone working with or near an AIV has been adequately trained, and is
following this user’s guide and the Mobile Robot LD Safety Guide, for safe AIV oper-
ation.

o Maintaining the AIVs so that their control and safety functions are working properly.
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General Hazards

IMPORTANT: The following situations could result in minor injury or damage
to the equipment.

» Do not ride on the platform or cart.
» Do not exceed the maximum weight limit.

e Do not exceed the maximum recommended speed, acceleration, deceleration, or rotation
limits. See Center of Gravity on page 76 and Acceleration, Deceleration, and Rotation
Limits on page 73.

Rotational speed becomes more significant when the payload’s center of gravity is
farther away (vertically and/or horizontally) from the platform’s center of gravity.

» Do not drop the AIV, run it off a ledge, or otherwise operate it in an irresponsible man-
ner.

o Do not allow the AIV to drive through an opening that has an automatic gate/door
unless the door and AIV are configured correctly with the Door Box option.

Refer to the LD Platform Peripherals Guide for details on the Door Box.

o Do not get the AIV wet. Do not expose the AIV to rain or moisture.

» Do not continue to run the AIV after hair, yarn, string, or any other items have become
wound around the platform’s axles, casters, or wheels.

» Do not use parts not authorized by Omron Adept Technologies, Inc.
e Do not turn on the AIV without the antennas in place.

o Although the lasers are Class 1 (eye-safe), we recommend you not look directly into
them.

Logical Barriers

You should also use forbidden areas, sectors, or lines with several feet of safety zone (padding)
before the actual dropoff, to ensure that the AIV will not try to drive there.

These need to be continuous at the site, so that the AIV can’t plan a path to drive around or
between them to the dropoff.

Electrical Hazards

WARNING: ELECTROCUTION RISK
The docking station has AC power inside. Its covers are not interlocked.

» Do not use power extension cords with the docking station unless properly rated.
o Never access the interior of the platform with the docking station attached.

o Immediately disconnect the battery after opening the battery compartment door.
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Avoid shorting the battery terminals.
» Do not use any charger not supplied by Omron Adept Technologies, Inc.

 If any liquid is spilled on the AIV, power off the AIV, clean up all possible liquid, and
allow the AIV to air dry thoroughly before restoring power.

Pinch and Entanglement Hazards

Latching System Latch

CAUTION: PINCH RISK
The latch of the LD Platform Cart Transporter can pinch you if you are not care-

ful. Keep your hands clear of the transporter when it is in action.

Latching System Belt/Pulley

CAUTION: PINCH RISK

During maintenance on the latch mechanism, the belt and pulley can pinch
you if you are not careful. Keep your hands clear of the belt and pulley when
they are in action.

The belt and pulley of the LD Platform Cart Transporter can entangle your
hand during maintenance. Keep your hands clear of the belt and pulley when
they are moving.

f WARNING: ENTANGLEMENT RISK

HMI Post-Cart Gap

CAUTION: PINCH RISK
The coupling action of the LD Platform Cart Transporter and cart can pinch

you if the cart payload is incorrectly designed, and you are not careful. Keep
your hands clear of the space between the HMI post and cart when the plat-
form and cart are coupling.

Platform Covers

CAUTION: PINCH RISK
The covers are held in place with strong magnets, which can pinch you if you

are not careful. Follow the instructions in the Maintenance chapter for hand-
ling covers.

IMPORTANT: The hazard presented by the platform cover magnets is slight
enough that the covers and their magnets do not have warning labels.
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Magnetic Field Hazards

Platform Covers

WARNING: MAGNETIC FIELD - MEDICAL IMPLANT RISK

Magnetic fields can be hazardous to medical implant wearers. Medical
implant wearers stay back 30 cm (12 inches) from the covers, which are held in
place with strong magnets.

Docking Funnel

WARNING: MAGNETIC FIELD - MEDICAL IMPLANT RISK

Magnetic fields can be hazardous to medical implant wearers. Medical
implant wearers stay back 30 cm (12 inches) from the underside of the plat-
form, which is exposed when the platform is tipped on its side during main-
tenance.

Cart Magnet
The underside of the cart has a strong magnet, used to signal the LD Platform Cart Transporter

that it is in place. This can be a hazard to medical implant wearers, if they get too close to it.

WARNING: MAGNETIC FIELD - MEDICAL IMPLANT RISK
Magnetic fields can be hazardous to medical implant wearers. Medical
implant wearers stay back 30 cm (12 inches) from the bottom of the cart.

Qualification of Personnel

It is the end-user’s responsibility to ensure that all personnel who will work with or around
AlVs have attended an appropriate Omron training course and have a working knowledge of
the system. The user must provide any necessary additional training for all personnel who
will be working with the system.

As noted in this and the Mobile Robot LD Safety Guide, certain procedures should be per-
formed only by skilled or instructed persons. For a description of the level of qualification, we
use the standard terms:

« Skilled persons have technical knowledge or sufficient experience to enable them to
avoid the dangers, electrical and/or mechanical

o Instructed persons are adequately advised or supervised by skilled persons to enable
them to avoid the dangers, electrical and/or mechanical

All personnel must observe industry-prescribed safety practices during the installation, oper-
ation, and testing of all electrically-powered equipment.

IMPORTANT: Before working with the AIV, every entrusted person must con-
firm that they:

o Have the necessary qualifications
o Have received the guides (both this guide, and the Mobile Robot LD Safety Guide)

o Have read the guides
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o Understand the guides

» Will work in the manner specified by the guides

Payload Movement and Transfer

Monitoring and confirmation of the status of AIV payload movement and transfer to or from
facility equipment is the end-user’s responsibility.

Payload transfer problems must trigger an AIV E-Stop, preventing the AIV from moving until
an Operator has resolved the problem and confirmed that the system is safe to use. This hand-
ling of payload transfer problems is the end-user’s responsibility.

Providing an interlock between the AIV and facility equipment is the user’s responsibility.

Configurable Warning Buzzer

The LD Platform Cart Transporters have a configurable warning buzzer. It is the user’s
responsibility to configure this buzzer as appropriate for the facility in which the AIV will be
operating. The buzzer will sound whenever the AIV is moving backwards or is turning. Other
situations are configurable.

The buzzer is configured with MobilePlanner, using the following parameters:

NOTE: These parameters are only available with the Mobile Robot Software
Suite 5.0 and later.

Table 2-1. Default Parameters

Parameter Default Setting

DriveWarningEnable True

NOTE: If this parameter is set to False, the
remaining parameters will not be displayed.

IMPORTANT: Disabling the DriveWarn-
ingEnable parameter violates the JIS D 6802
standard. It is strongly recommended that you
leave this set to True.

DoNotWarnDrivingForwards False

DoNotWarnTurningInPlace False

DriveWarningLoudMilliseconds | 500; If DriveWarningQuietMilliseconds is 0, this parameter is
irrelevant.

DriveWarningQuietMilliseconds | 500; This is the length of time between warnings that the
buzzer is silent. Setting this to 0 will cause a continuous warn-

ing.

Multi-AIV Avoidance

When multiple AIVs are operating in the same operating space, they must be connected to an
Enterprise Manager (EM) via WiFi. The EM helps prevent collisions by sharing AIVs’
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dynamic X, Y, Theta, size, and path-planning information with each other. AIVs then factor
this data into their obstacle avoidance. This is not an interlocked method of preventing col-
lisions. Ultimately, it is the end-user/integrator's responsibility to provide an interlocked
method of preventing collisions.

NOTE: If two AlVs are approaching each other, neither will see the other
because the incoming laser beams are detected as reflected beams. Because of
this, any installation with more than one AIV working in the same operating
space must be managed by the same Enterprise Manager.

Traffic Control

A "switchable forbidden area" can be programmed on the map to prevent the AIV from enter-
ing an area based on the state of a discrete input. If this input is set from another vehicle, such
as a forklift, while it is in that area, then the AIV will not be allowed to enter that area.

Passing Lanes

Since the LD Platform Cart Transporter technology does not use fixed tracks to guide the AIVs,
the concepts of passing lanes and human safety areas are not relevant.

2.4 Environment

General Environmental Conditions

It is the end-user’s responsibility to ensure that the operating environment of the platform
remains safe for the platform. If there are areas that are not safe for the platform to travel in,
those areas should be physically blocked off so that the platform’s scanning laser will detect
the barriers, and the platform will not attempt to drive there. These areas can also be blocked
off with forbidden zones in the MobilePlanner software, but that should be in addition to phys-
ical barriers.

Public Access

The LD Platform Cart Transporter is designed for operating in indoor industrial or pro-
fessional environments. It must be deployed in a manner that takes into account potential
risks to personnel and equipment. The product is not intended for use in uncontrolled areas
without risk analysis, for example, areas open to general public access. Use in such areas may
require deployment of additional safety measures.

Clearance

The LD Platform Cart Transporter is designed to operate in an environment that is generally
level and has no doors or other restricted areas too narrow for the platform and cart. It is the
user’s responsibility to ensure that adequate clearance is maintained on each side of the AIV,
so that a person cannot get trapped between the AIV and a wall or other fixed object. You
should consult the applicable standards for your area. An exception to side clearance can exist
at pickup and dropoff locations where the AIV must get close to conveyors or other fixed
objects.

The primary direction of travel of the LD Platform Cart Transporter is forward. When the trans-
porter is turning in place, with no forward movement, the detection of an obstacle in its path
of rotation will not trigger an E-Stop.
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CAUTION: PERSONAL INJURY RISK
Personnel who work with or around the transporter should not stand close to
the transporter when it is turning in place (with no forward motion).

Obstacles

If the LD Platform Cart Transporter will be entering high-traffic areas, the user must take appro-
priate precautions to alert people in those areas that an AIV might enter. If the traffic consists
of other machines, the user must adjust the AIV‘s and/or the other machine’s parameters to
reduce the risk of a collision.

Safety Scanning Laser Emergency Stop

If an obstacle enters the transporter’s immediate path, the safety scanning laser will trigger an
emergency stop. After the transporter has come to a complete stop, it will wait a minimum of
two seconds before resuming commanded motion, with no human intervention necessary.

o If the obstacle is still in the transporter’s path, it will first attempt to safely path plan
and maneuver around the obstacle, if there is adequate room.

o If the transporter can’t simply maneuver around the obstacle, it will search for another
path to reach its goal.

If it can’t find another path, it will wait for human intervention.

Safety System Overspeed Faults

A CPLD Channel 1 or 2 fault, is a system fault, reported by independent safety system to the
firmware controlling the robot. A fault signal from the safety system, indicates that the robot is
operating outside of the defined boundaries of safety standards EN1525/ANSI B56.5.

Both referenced standards state, that the speed of motion in directions not covered by the oper-
ator detection devices, reverse direction for the LD Platform, must be limited to <300 mm/s.

If an LD Platform is operated in a manner that exceeds this reverse speed limit, the safety sys-
tem will generate and report a fault signal. In normal, autonomous operation, this condition
triggers motion controllers to execute a controlled stop. However, if motion is disabled (E-Stop
button is pressed) and the brake release is overridden, the safety system cannot stop the LD
Platform since power to the motors has already been cut off. Once the fault condition is
resolved, the safety system will stop reporting safety fault to the motion controllers, and the
normal start-up process will initiate.

Following table displays overspeed fault conditions.
NOTE: The motion settings such as AbsoluteTransVelMax, that limit maximum

allowable velocities in the robot software (ARAM), have no effect on the safety
system.

Table 2-2. Overspeed Limits for Different LD Models

Model | Gear Ratio | Forward Limit (mm/s)¥ii | Reverse Limit (mm/s)!

LD-105CT 40:1 1575 225

LD-130CT 60:1 1050 150
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i These values are approximate and represent the upper limit. Maximum speeds should be set
to at least 30-50 mm/s below these values, to prevent erroneous safety overspeed faults.

ii The forward limits indicate where the safety system will report a fault. These speeds may not
be achievable by the robot under its own power. The max forward speed, should always be set
to the defined maximum (or lower) speed, found in the default configuration shipped with the
robot.

2.5 Intended and Non-intended Use

Intended Use

The LD Platform Cart Transporter is designed for operating in indoor industrial or pro-
fessional environments. It must be deployed in a manner that takes into account potential
risks to personnel and equipment. The product is not intended for use in uncontrolled areas
without risk analysis, for example, areas open to general public access. Use in such areas may
require deployment of additional safety measures.
Guidelines for safe use:
o C(lean, dry floors — floors that are regularly swept, and routinely kept free of debris and
liquids.

IMPORTANT: Since the robot is not water proof (IP20), floors must be
kept relatively dry, as any dampness can cause the wheels to slip. This
can cause problems for braking as well as navigation. Refer to 13849-2 for
instructions on how to test the robot in non-standard environments.

o Temperature — 5 to 40°C (41 to 104°F), with a recommended humidity range of 5% to
95%, non-condensing.
Non-Intended Use
The LD Platform Cart Transporter is not intended for use in any of the following situations:
o In hazardous (explosive) atmospheres
o Uncontrolled areas, for example, areas open to general public access

Application in such areas may require deployment of additional safety measures, and
risk analysis

LD Platform Cart Transporters are designed for operating in industrial or professional
environments. They must be deployed in a manner that takes into account potential
risks to personnel and equipment.

o In the presence of ionizing or non-ionizing radiation

« In life-support systems

 In residential installations

o Where the equipment will be subject to extremes of heat or humidity

« In mobile, portable, marine, or aircraft systems
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NOTE: The gyroscope used to assist in navigation in LD Platform Cart
Transporters requires a stationary environment for optimum accuracy.
Therefore, we do not recommend them for use on a ship, train, aircraft, or
other moving environment.

IMPORTANT: The instructions for operation, installation, and main-
tenance given in this guide and the AIV user’s guide must be strictly
observed.

Non-intended use of LD platforms can:

o Cause injury to personnel
« Damage the platform or other equipment
o Reduce system reliability and performance

The body of the AIV must not come into contact with liquids. The drive wheels can tolerate
damp floors, but the body of the AIV must remain dry.

If there is any doubt concerning the application, ask your local Omron support to determine if
it is an intended use or not.

Platform Modifications

If the user or integrator makes any changes to the LD Platform Cart Transporter or cart, it is
their responsibility to ensure that there are no sharp edges, corners, or protrusions.

Note that any change to the platform or cart can lead to loss in safety or functionality. It is the
responsibility of the user or integrator to ensure that all safety features are operational after
modifications.

2.6 Battery Safety

CAUTION: BATTERY DAMAGE RISK

Immediately charge the battery to a full charge upon receipt to avoid the risk of
discharging the battery below a usable state, which would require battery
replacement.

Effective April 1, 2016, IATA regulations require that air-shipped lithium ion batteries
(UN 3480, PI 965) must be transported at a state of charge not exceeding 30%. You should
charge the battery completely as soon as you receive it.

NOTE: If the battery was not sent by air, it may be fully-charged.

o Store batteries upright (in an environment with relative humidity less than 70%) at:

= One month: +5 to 45°C (41 to 113°F)
= One year: 20 to 25°C (68 to 77°F)

» Never expose the battery to water. If the battery is leaking, submerge it in mineral oil
and contact your local Omron support.

o In case of a fire, use a type D extinguisher: foam, dry chemical, or CO,.
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2.7 Additional Safety Information

Accidental Cart Separation

In the unlikely event that the cart becomes unlatched from the platform while in motion, the
brakes are designed to stop the cart within six feet.

Mobile Robot LD Safety Guide

Your local Omron support provides other sources for more safety information:

The Mobile Robot LD Safety Guide provides detailed information on safety for LD Platforms. It
also gives resources for information on relevant standards. It ships with each LD Platform.

2.8 Disposal

Dispose of in accordance with applicable regulations.

Customers can contribute to resource conservation and protecting the environment by the
proper disposal of WEEE (Waste Electronics and Electrical Equipment). All electrical and elec-
tronic products should be disposed of separately from the municipal waste system via des-

ignated collection facilities. For information about disposal of your old equipment, contact your
local Omron support.

34 LD Platform Cart Transporter User's Guide 14766-000 Rev G



Chapter 3: Setup

Overview

In general, setup is the physical preparation of the platform and cart, and physically marking
parking goal locations on your facility floor. Marking the parking goals on the floor is for
human use. An LD Platform Cart Transporter will not use those markings, although we recom-
mend you mark them in any case to prevent someone from placing something there that
would prevent a cart from being parked.

Setup also includes generating a map of the workspace and configuring the AIV with the
MobilePlanner software to perform useful tasks.

Tasks

This overview covers the LD Platform Cart Transporter starter kit, which includes the LD Plat-
form Cart Transporter with all components needed for use including a cart, a docking station,
and the software needed for navigation.

Install the battery in the platform. See Installing the Battery on page 45.
Fully charge the battery, either outside of or inside the platform.

Set up the wireless Ethernet for the platform. See Configuration on page 61.
Install the docking station. See Installing the Docking Station on page 49.
Install the cart’s manual brake-release cable and lever.

Design, build, and install a payload structure, to suit your application. See Payloads on
page 75.

This is the most involved task in getting your AIV working the way you want.
Configure the AIV for your environment, so it can perform useful tasks.

This includes generating the map that the platform will use for its navigation. This pro-
cedure and parameter configuration is covered in the Mobile Robot Software Suite User’s
Guide.

Mark the location and orientation of the goals where the cart can be parked. This allows
a person to place a cart where the transporter can find it.

It will also help keep someone from putting something other than a cart in that area,
which could prevent a cart from being parked in that location.

Configure the MobilePlanner software, so a transporter can pick up and drop off carts.

This includes modifying the map that the transporter uses for its navigation. The con-
figuration is covered in the Mobile Robot Software Suite User's Guide.

3.1 Transport and Storage

Use a forklift, pallet jack, or similar device to move the shipping containers.
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The containers must always be shipped and stored in an upright position in a clean, dry area
that is free from condensation. Do not lay the containers on their sides or any other non-
upright position.

LD Platform Cart Transporter

The LD Platform Cart Transporter system, which includes a cart, is shipped in one crate, along
with the docking station, joystick, and all components except for the battery.

The system must be shipped and stored in a temperature-controlled environment, from -20 to
60°C (-4 to 140°F). The recommended humidity range is 5% to 95%, non-condensing. It should
be shipped and stored in the supplied shipping crate, which is designed to prevent damage
from normal shock and vibration. You should protect the crate from excessive shock and vibra-
tion.

The transporter alone weighs 81 kg (179 1b).

The crate for the transporter measures 1257 x 1149 x 1645 mm (49.50 x 45.25 x 64.75 inches),
and weighs 129 kg (284 1b). The weight, as shipped, is 230 kg (507 1b).

Battery

NOTE: If you purchased spare batteries, this section applies to them, also.

The battery is shipped in a separate carton, not inside the platform or platform crate.
Storage Requirements
If the battery needs to be stored, the manufacturer recommends:

o +5 to 45°C (41 to 113°F) for up to a month

o 20 to 25°C (68 to 77°F) for up to a year

The battery should start storage fully-charged and upright, in a dry location. If storing the bat-
tery for an extended period, recharge the battery periodically to avoid total discharge, which
would damage the battery. Fully recharging a battery every six months is sufficient to keep it
charged enough to avoid damage.

Maintenance
Every six months:

« Inspect the battery for damage or leaks.

« Place the battery on a charger and allow to fully balance (battery shows all solid LEDs
when fully balanced). Fully recharging a battery every six months is sufficient to keep it
charged enough to avoid damage.

Standalone Cart
Carts can be purchased as an option, if you need more carts than transporters.

The cart box measures 1092 x 635 x 711 mm (43 x 25 x 28 inches). Weights are listed in the fol-
lowing table.
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Table 3-1. Item Weights

Item Weight

Cart 22.7 kg (50 Ib)
Cart and Box 28 kg (62 Ib)
Cart, Box, and Pallet | 44.5 kg (98 Ib)

Each cart comes with caster brakes, which require the installation of a brake-release lever. See
Installing the Cart Brake Release on page 54.

3.2 Before Unpacking

Carefully inspect all shipping containers for evidence of damage during transit. If any damage
is indicated, request that the carrier's agent be present at the time the containers are unpacked.

3.3 Unpacking

Before signing the carrier’s delivery sheet, compare the actual items received (not just the pack-
ing slip) with your equipment purchase order. Verify that all items are present and that the
shipment is correct and free of visible damage.

o If the items received do not match the packing slip, or are damaged, do not sign the
receipt.

o If the items received do not match your order, please contact your local Omron support
immediately.

Retain the containers and packing materials. These items may be necessary to settle claims or,
at a later date, to relocate the equipment.

A complete LD Platform Cart Transporter will come in two packages:
o The battery is shipped in a separate cardboard carton.
o The transporter and cart are shipped in a wooden crate.
This includes the HMI post with the side laser support tubes.

This also includes the joystick, docking station, as well as miscellaneous cords all in a
cardboard carton inside the transporter crate.

NOTE: If extra accessories are ordered, they will be shipped separately.

Battery

The battery is shipped separately from the transporter. Locate the box that contains the battery
before continuing. Refer to the following figure.
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Figure 3-1. Battery Shipping Container

The battery box measures 311 x 540 x 457 mm (12.25 x 21.25 x 18 inches).

NOTE: The battery weighs 19 kg (42 Ibs). There are recesses at the front and the
back of the battery, to aid in lifting it.
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LD Platform Cart Transporter

Figure 3-2. Cart and LD Platform Cart Transporter in Crate
The transporter crate measures 1257 x 1149 x 1645 mm (49.50 x 45.25 x 64.75 inches).

Removing the Front Panel

The front panel of the transporter crate doubles as a ramp, for rolling the platform off of the
crate base.

1. Release the latches that hold the front panel to the crate.

There are four spring-loaded latches.
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Figure 3-3. Spring-loaded Latch

2. Remove the front panel, and set it aside.

This will be used as a ramp, to roll the platform off of the crate base.

Removing the Upper Body of the Crate

1. There are six lag bolts and washers around the base of the crate, two in the rear and
two on each side. Remove all six lag bolts and washers.

Figure 3-4. Crate Lag Bolts

2. Slide the upper body of the crate off of the base.

Take care as you slide it over the HMI post, watching the clearance between the crate
and the HMI post components.

The platform will still be held securely by the base of the crate.
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CAUTION: PERSONAL INJURY OR PROPERTY DAMAGE RISK
Due to the weight and size of the crate upper body, and the potential to
damage the platform during this step, two people should work together
to remove it.

Removing the Cart

The cart is secured under a wooden panel and a cardboard box.
1. Loosen the restraining strap that is around the cardboard box.
2. Remove the cardboard box.
This contains the dock and the joystick, as well as miscellaneous cords.
If accessories, such as call boxes, are ordered, they will be shipped separately.

3. Release the two spring-loaded latches on either side of the panel that is securing the
cart.

Figure 3-5. Cart Panel Latches

4. Remove the panel and the straps off the top of the cart. Then remove the cart itself.

CAUTION: PERSONAL INJURY RISK
Due to the weight of the cart, two people should work together to remove it
from the crate.
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Removing the Crate Braces

1.

Remove the top brace by releasing the four spring-loaded latches, two on either side of

the brace.

Remove the front brace by releasing the two spring-loaded latches, one on either side of

the brace.

Figure 3-6. Crate Braces

Repacking for Relocation

If the LD Platform Cart Transporter or other equipment needs to be relocated, reverse the steps
in the installation procedures in this chapter. Reuse the original packing crates and materials

and follow all safety notes used for installation. Improper packing for shipment will void your
warranty.

The LD Platform Cart Transporter must always be shipped in an upright orientation.

3.4 Setting Up an LD Platform Cart Transporter

The LD Platform Cart Transporter is shipped with the HMI post installed. This includes the
Operator panel at the top of the HMI post. You will have to:

42

Roll the transporter off of the crate, down the ramp
This will be rolling on the casters, not the drive wheels.
Remove the pins holding the drive wheels up

Install the battery

Install the dock, for charging the transporter’s battery
This should have already been removed from the crate.
Set up your wireless system

This is covered in Settings and Configuration on page 61.

LD Platform Cart Transporter User's Guide
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Rolling the LD Platform Cart Transporter off of the Crate Base
1. Install the crate front onto the crate base, to serve as a ramp.

There are two hanger bolts that stick up out of the front of the crate base. These fit into
two holes in the end of the ramp. Orient the ramp as shown in Figure 3-7. to ensure
there is a smooth transition between the ramp and the ground.

2. Roll the transporter off of the crate base and down the ramp.

Figure 3-7. LD Platform Cart Transporter on Crate Base, with Ramp

3. Remove the two wheel pins that held the wheels up during transit.

The wheels are pinned up to protect the motors and drives. When you receive your LD
Platform Cart Transporter, the drive wheels will not touch the ground until you remove
the wheel pins. The wheel pin hole is shown in the following figure.
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Fiqure 3-8. Wheel Pin Hole Location

For each side of the platform:

a. Remove the side cover a small distance from the platform. Refer to Removing
Covers on page 159.

The light disc PCA cable will still be attached.

b. Disconnect the cable from the light disc PCA, so the side cover can be moved
completely away from the platform.

This will fully expose the wheel and tire.

c. Lift the wheel slightly to relieve pressure on the pin.

d. Remove the pin by pulling the ring that is attached.

These pins can be used for later service of the entire drive assemblies.

Figure 3-9. Wheel Pin
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e. Lower the wheel to the floor.
The wheels are spring-loaded, and the wheel brakes will be on.

f. Put the side cover next to the platform, and attach the light disc cable to the light
disc PCA.

g. Reinstall the side cover.

Installing the Battery

Your platform battery comes with less than 30% charge, to comply with air-shipping reg-
ulations. It should be charged as soon as possible, to a full charge.

NOTE: Air shipping regulations require that the tranporter be shipped without
the battery installed.

Removing the Battery Cover

Accessing the battery compartment requires removing the platform's rear cover. This is held in
place with magnets.

CAUTION: PINCH RISK
The magnets holding the cover in place are strong enough to pinch you if you
are not careful.

No tools are needed for either the removal or installation of the battery cover.

NOTE: After removing the cover, place it inner-side down, so the outer surface
doesn't get scratched.
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Figure 3-10. Pulling the Bottom of the Rear Cover Out

Figure 3-11. Lowering the Rear Cover
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Refer to Removing and Installing LD Platform Cart Transporter Covers in the Maintenance sec-
tion for cover removal and installation.

1. Remove the inner rear platform cover.
a. Pull the bottom of the cover away from the platform chassis.
This is easiest if you grip it with two hands, toward the center.

b. Lower the cover down, so its top tab clears the rear outer cover.

2. Unlatch and open the battery compartment door, at the back of the platform.

The battery compartment door is capable of being locked. You may need to unlock it.
3. Lift and slide the new battery into the platform body.

The battery weighs 19 kg (42 Ibs).

There are recesses at the front and the back of the battery, to aid in lifting it.

Figure 3-12. Battery Recesses, for Gripping

The battery is designed to be lifted and replaced by one person, using one hand in each
of the grips, as shown in the following figure.
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Figure 3-13. Lifting the Battery

The connectors for power and data go toward the rear of the platform.

4. Attach the battery power and data cables to the connectors at the rear of the battery.

Figure 3-14. Battery Cable Connectors, (A) Power and (B) Data

5. Close the battery compartment door to secure the battery in place.

The battery compartment is designed to hold the battery tightly, so that it will not move
within the compartment, once the door is closed.

6. Reinstall the inner rear platform cover.
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Installing the Docking Station

The automated docking station can be used for either manual or automated charging of your
LD Platform Cart Transporter's battery.

The docking station sits on the floor. It can be attached to a wall with the wall bracket,
attached directly to the floor with screws through its base, or it can sit stand-alone on the floor
with the floor plate, all of which will keep the docking station from moving when the trans-
porter docks. Each docking station comes with a wall bracket and floor plate.

NOTE: It is very important that the docking station be mounted with one of
these methods, or the transporter will simply move the docking station when it
tries to dock, rather than docking successfully.

Regardless of mounting method:

o Locate the docking station near an AC outlet with 1-2 m (3.25-6.5 ft) of clear space in
front to ease the transporter’'s maneuvers onto the docking station.

« When docked, the rear-facing laser extends almost 5 inches beyond the back of the dock-
ing station. Ensure that you leave enough free space behind the back of the docking sta-
tion to allow clearance for this.

The wall-mount bracket provides enough room for this.

 The top of the docking station foot is spring-loaded, and lifts off of the bottom of the foot
slightly to accommodate variations in the floor surface. The weight of the transporter
will push the top of the foot down.

Requirements
» 100-240 VAC, 50/60 Hz, 8 A
The station's power converter automatically detects the source voltage.

« Ambient operating temperature: 5 to 40°C (41 to 104°F)

e 5% to 95% humidity, non-condensing

Wall Bracket Mount

NOTE: This is the recommended method for mounting the docking station.

1. Attach the docking station mounting bracket to a wall, with the bottom edge of the
bracket 98+20 mm above the floor, using user-supplied anchors and screws. There is lee-
way, so you can adjust the height a little bit.

Refer to the following figure:
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Figure 3-15. Docking Station, Wall Mount Bracket Detail, (A) Through Hole (units are in mm)

2. Screw the two shoulder bolts, each with a washer, into the rear of the docking station.
The shoulder bolts are M5 x 4, stainless steel. Their locations are shown in the fol-
lowing figure. Tighten to 9 N-m (80 in-Ib).

LD Platform Cart Transporter User's Guide
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Figure 3-16. Rear View of Docking Station with Shoulder Bolts

3. Lower the docking station down, so the two shoulder bolts on the back of the docking
station slide into the bracket, to secure the docking station to the wall.

Floor-mount, without Floor Plate

NOTE: Because this method permanently attaches the dock to the floor, it may
be subject to building code regulations. It is the user’s responsibility to verify that
the installation is in compliance with local regulations.

Screw the base of the docking station directly to the floor, using three user-supplied screws. For
dimensions of the available holes in the base, refer to Figure 3-15. We recommend M5 self-tap-

ping or M4 drywall screws for this.

Floor-mount, with Floor Plate

This mounting method uses the floor plate. The floor plate is not shipped attached to the dock-
ing station, so you must attach it for this type of mount. It will be in the crate with the docking
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station.
Attaching the Floor Plate
Refer to the following figures.

1. Tip the docking station onto its back, so you can access the underside.

2. Remove the two lowest screws (M4 x 12 flat-head), if present.

In the following figure, these screws are circled. The location of the third screw hole is
also circled.

3. Attach the floor plate to the base of the docking station with three M4 x 12 flat-head
stainless steel screws.

The floor plate comes with three screws, so you will have two spares.

The docking station and floor plate do not need to be attached to the floor, as the weight of the
platform on the floor plate will keep the docking station from moving.

Figure 3-17. Underside of Docking Station Foot, Showing Screw Locations

NOTE: These are the three locations for the M4 x 12 flat-head screws. Two are
already in place, and need to be removed before attaching the plate.
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Figure 3-18. Docking Station, Mounted on Floor Plate

406

— 495

Figure 3-19. Docking Station Floor Plate Dimensions (units are in mm)
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3.5 Installing the Cart Brake Release

Power On

Install the power cord and turn the power switch to ON. The power switch is next to the
power plug. The blue power LED indicator should light.

Docking Station Contact Adjustment

The contacts on the docking station have five height settings. The station is shipped with the
height in the middle setting, which should be correct in most cases. The height can be changed
by tilting the station enough to see the bottom of the base, making the adjustment accessible.

Additional Information: Squeeze and keep the docking station foot against the
bottom of the docking station to make this adjustment easier.

Adjust the height of the contacts by using the pull-knob on the bottom of the dock. The height
changes by 4 mm (0.15 inch) for each notch. See the following figure.

The height of the contacts should be set so that the roller is high enough to stay in contact with
the platform as it is docking, but low enough so that the bi-level of the roller guides the paddle
under the platform.

Figure 3-20. Docking Station Contact Adjusting Pull-Knob

3.5 Installing the Cart Brake Release

The two rear casters of the cart have brakes, which push a blunt pin against the caster rolling
surface to prevent the cart from rolling when it is parked on a floor that is not perfectly level.
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Figure 3-21. Cart Caster Brake, Showing Spring and Pin

To allow an Operator to release the cart brakes when there is no cart LD Platform Cart Trans-
porter present, each cart comes with a brake-release cable and lever, similar to a bicycle hand
brake, that releases the cart brakes when squeezed.

NOTE: The cart brake-release mechanism is actuated by the transporter when it
couples with the cart, so the cart will roll freely with the transporter. This part of
the brake release does not requires any user setup or adjustment.

Installation

The cart brake cable is attached on one end to the cart brake-release mechanism, and outfitted
on the other end with a bicycle-style brake lever, to release the cart’s brakes and allow an Oper-
ator to move the cart manually. It is up to the user to mount the brake-release lever at some loc-
ation on the cart, and route the brake-release cable from the brake-release lever to the actuator.
The brake-release lever comes with a 1524 mm (60 inches) cable. The lever has a clamp the fits
a 22 mm (7/8 inch) tube.
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Figure 3-22. Brake-release Lever

CAUTION: PERSONAL INJURY RISK
It is important that the brake-release handle be mounted in an ergonomically-
suitable location, so an Operator can repetitively release the brakes without risk-

ing injury.

The actual mounting location and procedure for the brake-release handle are not covered here
due to the variability that is possible in cart structure designs. Ensure that no part of the cart
brake-release cable bends more than a 76 mm (3 inches) radius.

There is a 6.4 mm (0.25 inch) horizontal hole through the rear horizontal tube of the cart. See
the following two figures.
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Figure 3-23. Thru-hole for Brake-release Cable, (A) 6 mm diameter (0.25 in.) pass-through hole for
brake cable, through rear frame tube

®

Fiqure 3-24. Thru-holes for Brake-release Cable, Plate Removed
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3.5 Installing the Cart Brake Release

Callout Description Callout Description
A Route brake-release cable up to C Secure brake-release cable to
brake lever saddle tie
B 6 mm diameter (0.25 in.) hole
through rear tube wall

After the brake-release lever has been mounted on the cart payload:

1. Push the free end of the lever cable through the hole in the cart’s upper-rear horizontal
tube.

7 B
A

lf -

- ——®

Figure 3-25. Internal Brake-Release Mechanism

Callout Description Callout Description
A Right Brake Cable F Actuator Bar
B Right Brake Adjust G Actuator Bar Hard Stop
Cc Lever Cable H Left Brake Cable
D Pulley I Left Brake Adjust
E Lever Cable Anchor K Lever Cable Clamp

2. Route the cable to the lever cable anchor.

3. Attach the actuator end of the cable to the lever cable anchor.
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4. Run the inner wire of the cable around the pulley, through the bushing in the actuator
bar, and through the lever cable clamp.

5. Pull the inner wire tight enough to remove slack, and tighten the lever cable clamp on
it.

6. Cut off the excess inner wire, leaving a small amount protruding past the clamp.
7. Make a service loop of any excess lever cable, at least 152 mm (6 inches) in diameter.

8. Attach the lever cable housing to the saddle tie. See Figure 3-24.

Adjustment
The brake lever cable needs to be adjusted so there is no excess slack, but so the brakes are
engaged when the lever is not being actuated. The two caster brake cables will be adjusted at
the factory.

Brake Lever Cable
The brake lever cable should be adjusted at the lever cable clamp, shown in the preceding fig-
ure. There should be just enough slack so the actuator bar touches its hard stop.

Caster Cables

These should be adjusted correctly from the factory. If any adjustment is needed, refer to the
preceding figure for the adjustment location. The brake pins should be able to go down as far
as the caster surface allows, without any slack. The jam nuts on the two brake adjustments
should be installed using a threadlocker.

Actuator Bar Hard Stop

After the caster cables are adjusted correctly, ensure that the actuator bar just touches its hard
stop. This will keep the actuator bar in position if you have to adjust the lever cable.
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The LD Platform Cart Transporter comes with firmware and on-board software installed.

Configuration of an LD Platform Cart Transporter is done using the MobilePlanner software.
Configuration includes generation of the map that the AIV will use for navigation. The cart
parking goals need to be added to that map. This manual only provides an overview of that
process, which is covered in detail in the Mobile Robot Software Suite User’s Guide.

IMPORTANT: The MobilePlanner dongle, which contains the license for run-
ning the software, should be locked up when not in use, to prevent unauthorized
modifications to your system configuration. Turn off the software when not in
use.

Other setup, mostly for communication, is handled by the SetNetGo OS, which is accessed
through the MobilePlanner software. It can also be accessed through a direct connection, so
your IT support can set up your wireless without needing the MobilePlanner license.

The transporter navigates using a map, generated with the MobilePlanner software. The oper-
ation of this software, as well as the downloading of the resultant map to the platform, is
covered in the Mobile Robot Software Suite User’s Guide.

NOTE: The map must be generated and downloaded to the platform before you
can perform the steps covered in this chapter.

By default, the LD Platform Core, safety scanning laser, and some auxiliary power start auto-
matically when you press ON.

4.1 Settings and Configuration

Maintenance Ethernet Connection

To prepare your AIV for autonomous mobile operation, attach a PC to the platform’s Main-
tenance Ethernet port, and connect with the SetNetGo OS through the MobilePlanner SetNetGo
interface.

If you do not have wireless yet, you can connect MobilePlanner through the wired Ethernet
port (Maintenance LAN) and set up the wireless network later.
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Figure 4-1. (A) PC, (B) Cat 5 Ethernet, and (C) Maintenance Access Panel

The LD Platform core is preset and tested on a Class-C network (netmask for all ports
255.255.255.0). The Maintenance Ethernet port is set to IP address 1.2.3.4 and the wireless IP
comes set with an AP-based ("managed") SSID of “Wireless Network”, unsecured. Consult
with your network systems administrator before modifying these network details through the
SetNetGo OS.

The User LAN port is set to IP address 10.10.10.10.
Refer to the Mobile Robot Software Suite User’s Guide.

The Maintenance Ethernet port is on the left side of the platform, under the small access panel
at the upper-right corner of the platform. (The joystick port is also there.) The access panel is
held in place with a push-push latch, and retained by a lanyard. See Figure 10-3. This is
internally connected to the Ethernet port located on the rear side of the LD Platform core in the
payload bay.

The Maintenance Ethernet port is permanently set to IP address 1.2.3.4, with a netmask of
255.255.255.0, for direct, wired access to the onboard systems. Accordingly, when accessing the
port, manually set the offboard computer’s Ethernet to an IP 1.2.3.x, where x is any number 1
through 254 except 4, and with a netmask of 255.255.255.0. No special DNS or gateway set-
tings are needed.

Attach a pass-through or cross-over CAT5 (or better) Ethernet cable between the PC and the
Maintenance Ethernet port of the platform. The platform Ethernet is Auto-MDIX, and will
detect the type of cable you are using.

Start the Network Connections: Local Area Connection dialog for the ETH 0 Ethernet port:

(Windows 7) Start > Settings > Network Connections > Local Area Connection

(Windows 10) Start > Settings > Network and Internet > Change Adaptor
Options > Local Area Connection

Select Properties, and, from its dialog, scroll to and double-click the Internet Protocol (TCP/IP
or TCP/IPv4) option. In the Internet Protocol (TCP/IP) Properties dialog, click both ‘Use the fol-
lowing...” associated radio buttons to enable them, and then type in the IP and netmask val-
ues.
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Setting Up Wireless Ethernet
The SetNetGo OS is used to configure the platform wireless Ethernet, among other things. Refer
to the Mobile Robot Software Suite User’s Guide for details.

NOTE: Although an LD Platform Cart Transporter is capable of working
without wireless Ethernet if there are no other AlIVs that it needs to know about
(and to avoid), that is the exception. In most cases, wireless Ethernet will be
needed.

NOTE: For all of the following settings, work with your IT group to verify the
correct IP, radio, and security settings.
The following applies to the wireless Ethernet supported by the platform.

The SetNetGo OS is used to configure the wireless Ethernet, among other things. Refer to the
Mobile Robot Software Suite User’s Guide for details.

Access the SetNetGo OS through the MobilePlanner software:

MobilePlanner > SetNetGo > Network

NOTE: ltis also possible to connect directly to the SetNetGo OS on a platform
through a web browser. The main intent of this is to allow your IT support to set
up the network for you, without using MobilePlanner, which requires a license.

IP Address, Netmask, Gateway, DNS 1
Choose Static (DHCP is not recommended), and fill in the IP address, netmask, gateway, and
DNSI, as supplied by your network administrator.

NOTE: The following settings have to be provided by your IT department.

Radio Settings
» SSID (e.g. AGV)

Fill in the appropriate wireless SSID for your wireless network.
The SSID is case sensitive.

e Mode
Managed/STA, Ad-Hoc, or Master/AP
o Radio Mode
Auto, 802.11a, 802.11b, 802.11g
e Channel Set
o Wireless Watchdog IP Address

o Wireless Watchdog Max Count
0 disables this.
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Security Settings
Encryption:
o Disabled
o WEP 64-bit
o WEP 128-bit
o TKIP/RC4
« CCMP/AES
o TKIP/CCMP/AES

Authentication:
« OPEN

o« WPA-PSK
« WPA2-PSK
WEP
o WEP Key Number (Key 1 - Key 4)
o WEP Keys

WPA/WPA2-PSK
o PSK

o PSK-Type (Passphrase or Raw Hex)

Click Apply for your changes to take effect.

Wireless Coverage

The AIV must have wireless coverage for multi-AIV installations, or in areas where you wish
to send new commands to or receive status updates from the AIV.

Ensure that, in such cases, you have adequate wireless coverage. Because of the variation pos-
sible in different environments, we don't specify what components or techniques should be
used to obtain this coverage.

We suggest that you conduct a comprehensive site survey to ensure adequate wireless cov-
erage. You can test the coverage of your wireless setup by trying to ping it from various loc-
ations.

>= 40 dBm is the ideal WiFi signal strength, -60 dBm is the recommended minimum.

Bandwidth Considerations

The typical bandwidth in a fleet will average about 50 Kbps/AIV. This would increase if the
AlV is connected to the Enterprise Manager, and is actively viewed by MobilePlanner. This
number can increase or decrease depending on the types of commands and debugging tools
that are enabled in MobilePlanner. In any case, the bandwidth is not likely to exceed 500 Kbps
per ALV (0.5 Mbps).
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0.5 Mbps per AIV would easily fit within the capabilities of access points (>=54 Mbps). If you
have multiple access points, this number becomes even less of a concern.

Also, other factors will affect the bandwidth requirements, such as if the AIV supports a cam-
era on top and streams the video through the AIV’s WiFi interface. Based on such possibilities,
the bandwidth usage will vary by application.

4.2 Mapping

Mapping Overview

There are many options for configuring and tuning your LD Platform Cart Transporter to best
suit your application.

In order to have your transporter perform autonomous mobile activities, you need to make a
map of its operating space. Configuration includes generation of the map that the transporter
will use for navigation. The cart parking goals need to be added to that map. Use the
MobilePlanner application to make the map. This manual only provides an overview of that
process, which is covered in detail in the Mobile Robot Software Suite User’s Guide.

Maps may contain a variety of virtual elements which act to modify the behavior of an AIV.
Virtual elements include forbidden lines and areas, speed zones, preferred-direction zones, and
more, all working to help you configure your workspace for efficient and safe performance of
your mobile application. You can also create your own virtual elements for application-specific
AIV-workspace interactions.

Maps contain a variety of goals, routes, and tasks that comprise the destinations and activities
of the AIV in the workspace. There needs to be a goal at every location where you want the
transporter to be able to pick up or drop off a cart. Make sure that the goal orientations leave
room for the platform to maneuver.

Mapping Tasks

 Install the automated docking station before you create a map file. Its distinctive front
angle will be helpful in locating it on the map.

« Drive the platform with the joystick to make a floor plan scan. We recommend that you
drive it to and position it onto its automated docking station to prepare for the next
steps.

o Load that floor plan scan into MobilePlanner, on your PC, to make and edit the map.

o Add goals and docks to your map. In particular, refer to:

Working With Map Files > Editing a Map File >
Using the Drawing Tools > Adding Goals and Docks

in the Mobile Robot Software Suite User’s Guide.

o Transfer the working map to the Enterprise Manager, or back to the platform, if you
have only one platform, to perform autonomous mobile actions.

The Enterprise Manager will automatically download the new map to each AIV in your
fleet as soon the AIV becomes idle.

 If you have multiple, separate working spaces, which will each require their own map,
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you can save map collections and deploy your platform in any of your working spaces
by selecting the appropriate map file.

Setting Up Cart-Parking Goals

Any location where you want a cart to be picked up or dropped off needs to have a cor-
responding goal on the map. Pay special attention to the direction of the goals, as the trans-
porter may need extra room to maneuver into the correct position for coupling.

Marking Cart-Parking Goals on Floor

The purpose of marking the parking goals on your floor is so that a human being knows
where to leave a cart, so that the transporter will find it and be able to couple with it.

Even if people will never be moving carts, this step is recommended, so that someone doesn’t
place other items where a cart needs to be parked.

If people will be moving carts, make sure that your markings include the direction of the goal,
so the transporter will be approaching from the correct direction.

The easiest way to accurately mark the goals where a cart may be parked is to send the trans-
porter to each cart-parking goal, and, while the transporter is at the goal, put down tape mark-
ings that include the size of the cart, as well as the transporter’s orientation. The transporter
will always approach the goal from the same direction, so the cart needs to be oriented cor-
rectly.

4.3 Configuring a Touchscreen

You configure the touchscreen's appearance and behavior with the MobilePlanner software.
The tasks include setting the mode to use, setting up goals for relocalization, and specifying a
custom screen logo and the language to be used for the display.

Touchscreen Ethernet Setup

The touchscreen plugs into the User LAN port on the platform’s core.

NOTE: After making and saving changes within User LAN Ethernet Settings,
the platform has to be power-cycled for those changes to take effect. If the only
change is to enable DHCP, then the platform does not have to be power-cycled.

In the MobilePlanner software, select:
MobilePlanner > SetNetGo
Network > User LAN Ethernet

Ensure that:

o the IP address subnet doesn’t conflict with the Wireless Ethernet IP subnet
o Interface mode is set to Accessory
« DHCP Server for Accessories is set to Enable

o DHCP IP Range is large enough to provide IP addresses for all connected devices
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Figure 4-2. Accessory and DHCP Server for Accessories Enabled

Operating Modes
Specify the touchscreen mode: either Choose Dropoff or Patrol Route.
o Choose Dropoff mode allows the Operator to input the next dropoff goals.

 Patrol Route mode simply drives around a specific route. The AIV will have goals that
it stops at, but the Operator will not be able to alter the order of those goals.

For Choose Dropoff, you specify how many dropoff buttons there will be, and how each button
is labeled, as well as the goal on the AIV's map that gets associated with each button.

For Patrol Route, you specify the name of the route and whether to start the patrol on bootup.
The route will include whatever goals the AIV will stop at, and how long it will wait at each
specific goal.

These parameters are accessed from:
MobilePlanner > Config, then Robot Interface > Touchscreen

Select either Choose Dropoff or Patrol Route with the Pages > MainPage parameter, which has
a dropdown selection box.
Choose Dropoff Mode

The following parameters only apply to the Choose Dropoff mode.
Dropoff Priority

This is accessed under Pages > ChooseDropoffPage.

You can enable high-priority dropoffs, which will be serviced before normal-priority dropoffs.
The Operator can specify that a goal is high-priority when it is being selected for the upcoming
dropoff.

AllowHighPriorityDropoffs

This allows some dropoffs to be specified as high-priority. This is enabled by
default, and you can disable or re-enable it in the MobilePlanner software.
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HighDropoffPriority

This is the priority assigned to any dropoff that is specified as high-priority.
Higher priority jobs will be serviced before lower-priority jobs by the queuing
manager. This has no effect if AllowHighPriorityDropoffs is disabled.

Dropoff Buttons
This is accessed under Pages > ChooseDropoffPage.

DropoffButtonCount

This specifies the total number of buttons that will be available on the touch-
screen page. You can scroll the page to see other buttons, if all of the buttons can-
not be displayed at once.

DropoffButtonx

There will be a DropoffButton1 through DropoffButtonx, where x = DropoffBut-
tonCount. Each contains the two following parameters:

GoalName

This is a combo box that lists all of the goals that have been created
on the map. Select the map goal to be serviced when this dropoff
button is pressed.

NOTE: A goal can have a wait time associated with
it, to give an Operator time to load or unload the AIV.
This is configured, in the map, using the MobilePlan-
ner software.

You can eliminate a button from the screen by making GoalName
blank. The other buttons will fill in, so there will be no blank spaces
in the screen.

ButtonLabel

This is the text label displayed on the dropoff button. If empty, the
GoalName is displayed.

Patrol Route Mode
The following parameters only apply to the Patrol Route mode.

In this mode you need to specify the name of the Patrol Route that the AIV will patrol. The
route needs to have already been set up using the MobilePlanner software. You also need to
specify if the AIV will start its patrol automatically, or if it requires an Operator to press Go.

Select Pages > PatrolRoutePage

o In RouteName, enter the route to be patrolled.

o Check AutoStartRoute for the AIV to start its patrol as soon as the Patrol Route screen is
displayed (the touchscreen has finished booting).
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Localization Goals

You need to configure at least one localization goal. You can configure more if you want. A loc-
alization goal is needed to relocalize a lost AIV from the touchscreen.

Each localization goal should have:
» a heading
The AIV will need to be aligned with the heading when relocalizing.
This applies to both laser and Acuity localization.
» mapped features that don’t change much

Things that get moved frequently, such as pallets, chairs, or carts do not make good
mapped features, because the map will not match what the laser is seeing.

« mapped features that don’t get blocked

If a mapped wall is often used for stacking boxes or storing carts, the laser may have
trouble seeing the wall behind those objects.

» multiple visible lights, when using Acuity localization
The more lights the AIV can see, the better.
 a high localization score

This represents the percent of readings that the AIV currently sees that match the fea-
tures on its map.

NOTE: Localization goals do not have to be dedicated to localization - they can
also be used as normal goals for regular use.

In MobilePlanner, select:
Config > Robot Interface > Touchscreen

From there, use ChooseLocalizationPage to set LocalizationButtonCount to the number of loc-
alization goals you want, and then specify the GoalName and ButtonLabel for each.
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Figure 4-3. Localization Goal Parameters

Screen Logo
In MobilePlanner, select

Config > Robot Interface > Touchscreen

From there, use Style/Appearance.

A logo is displayed in the upper-left corner of the touchscreen. The default logo is Omron, as
shown in the following figure.
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Figure 4-4. Sample Touchscreen, with Omron Logo, in Choose Dropoff Mode

You can customize this with a logo of your choosing using the following steps:
1. Upload a PNG image file to the AIV using the MobilePlanner software:
File > Download/Upload
2. Open the Configuration window and choose:
Robot Interface > Touchscreen
3. Edit the SmallLogo parameter.

a. Click the file-select button to open the file chooser.
b. Select the newly-uploaded file.
c. Click Open.

4. Click Save, to save the configuration.

NOTE: If the SmallLogo field is left blank, the default Omron logo will be dis-
played.

NOTE: If a different version of the same file name is uploaded to the AIV, you
will need to power cycle the AIV to see the change.

Screensaver

In MobilePlanner, select
Config > Robot Interface > Touchscreen

From there, use Screensaver.
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If the AIV is in motion when the screensaver comes on, it will use the Busy icon, and display
a status message (where it's going). If the AIV is not in motion, it will display the Available
icon. The rounded rectangle, icon, and any text inside the rectangle will move around the
touchscreen display area.

Screensaver Enabled
This is a checkbox that determines whether a screensaver is displayed when the touchscreen is
inactive. Checking the box enables the screensaver.

TimeoutSeconds
This is the number of seconds that will elapse before the screensaver is turned on. This has no
effect if the Screensaver Enabled box is not checked. The range is 1-999 s.

StayOnTouch
This is a checkbox that determines if touching the screensaver has the same effect as touching
Stay. If this is checked, the AIV will stay when the screensaver is touched.

Display Language

You can select what language is used for the display from a dropdown box in the MobilePlan-
ner software.

NOTE: Some messages from the AIV will be in English, regardless of the lan-
guage set here. These include status and mode messages.

From MobilePlanner, select:
Config > Robot Interface > Language/Location

Select RobotLanguage, which has a dropdown selection box.

This parameter is not touchscreen-specific, so it may affect other displays that involve written
language. As of this writing, only the touchscreen is affected. This parameter does not affect
synthesized speech.
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Contact Information

Figure 4-5. Help Screen, with Contact Information

Help shows installed software and contact information.

NOTE: No contact information will be displayed unless it is set up in the
MobilePlanner software.

In MobilePlanner > Config:

» Robot Interface > Touchscreen > ContactInformation
o Check the ShowContactPage checkbox.

 Enter appropriate information in ContactName and the fields following it.

4.4 Acceleration, Deceleration, and Rotation Limits

CAUTION: PROPERTY DAMAGE RISK
If you change AbsoluteMaxTransVel, you should commission the AIV before put-
ting it into service.

Reducing the absolute max allowable linear and rotational acceleration, deceleration, and
speed will affect the size of the allowable CG envelope, but it may do so in non-obvious ways.
For use-cases where the payload can’t be decreased, or the CG can’t be brought within the
recommended limits, our Field Service department can work with your system designer to
input your needs into our models.

Contact your local Omron support for details.
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If your payload’s center of gravity is not within the guidelines given in the Payloads chapter,
you will need to adjust the Absolute Movement Maximums parameters in the MobilePlanner
software.

From the MobilePlanner software, Config:
Robot Physical > Absolute Movement Maximums

Show Expert + Parameters needs to be checked to see or modify these parameters.

The first four parameters and AbsoluteMaxRotVel are not likely to have significant impact on
the AIV’s stability. The Accel and Decel parameters will have a major impact. In certain cases,
if the payload is lopsided, the AbsoluteMaxRotVel may need to be adjusted.

The limits and defaults for these parameters are listed in the following table.

Parameter Default| Min Max
AbsoluteMaxTransVel (LD-105CT) 1350 1 2500
AbsoluteMaxTransVel (LD-130CT) 900 1 2500
AbsoluteMaxTransNegVel (LD-105CT) | -210 -25002 | -1
AbsoluteMaxTransNegVel (LD-130CT) [ -140 -2500° | -1
AbsoluteMaxTransAccel 1000 1 2000
AbsoluteMaxTransDecel 2000 1 2000
AbsoluteMaxRotVel 180 1 180
AbsoluteMaxRotAccel 360 1 360
AbsoluteMaxRotDecel 360 1 360

a: Although the Min value, in software, is -2500, the hardware safety system on the platform will
generate a fault if the velocity is anything from -300 to -2500 mm/s.

4.5 Supplemental Information

Laser Setup

For most installations, the defaults for the lasers should be appropriate, and will not require
any user adjustment.

The specific parameters for these lasers will come in the model config file that ships on the
unit, or can be provided on request if needed.

o Laser_1 Settings are for the main scanning laser (5300), used both for safety and loc-
alization.

o Laser_2 Settings are for the low front laser (TiM).
o Laser_3 Tilted and Laser_4 Tilted are for the side lasers (TiM).
o Laser_5 Settings are for the coupling laser (TiM).

o Laser_6 Settings are the rear-facing laser (TiM).
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5.1 Safety

Warning Label

A No Riding label ships, unattached, with each platform. You must place this in a prominent
location on the payload, so operators will see it.

Other warning labels are applied at the factory.

Drive Warning Light

For CE compliance, an AlV is required to have a readily-visible warning light, when it is either
ready to move or is moving. The platform comes with light discs on each side, and the HMI
post has a beacon, designed to be higher than a normal payload, to do this.

If you have a payload that blocks the beacon, the core also provides an output, so you can add
your own warning device. This may be necessary for taller payloads, which may make the
beacon not always visible. The core has a Light Pole connector, which is covered in the Con-
nectivity chapter in LD Platform Core Rear, Upper on page 96. This can be used to drive a
warning light in a more prominent location for taller payloads.

Turn Warning Lights

An AlV is also required, for CE compliance, to have readily-visible turn warning lights, when
it is either turning or about to turn. The platform’s light discs indicate that the AIV is turning,
and in which direction.

If you have a payload that blocks the beacon, the core also provides an output, so you can add
your own warning device. This may be necessary for taller payloads, which may make the
beacon not always visible. The core has a Light Pole connector, which is covered in the Con-
nectivity chapter in LD Platform Core Rear, Upper on page 96. This can be used to drive a
warning light in a more prominent location for taller payloads.

Warning Buzzer

The core provides an output for driving a warning buzzer. The default behavior of the buzzer
is to sound when the AIV is moving in reverse, or when the safety systems are off. Its behavior
is configurable by the user, so it can be used to sound, for example, whenever the AIV is mov-
ing.
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5.2 Considerations

Dimensions
You must keep your payload no wider and no longer than the LD Platform Cart Transporter.

Take care to keep all of the sensors exposed. If any of the sensors get blocked, the AIV won't be
able to function as intended. This is critical in the case of the lasers.

The payload design must not obstruct the side lasers' field of view.

If you have Acuity localization, you need to make sure that the height of your payload does
not obstruct the camera’s field-of-view. The Acuity camera lens has a 140° field-of-view, so
take care that nothing higher than the camera lens is close beside the camera.

Pinch Hazard

There is a potential, with an improperly-designed cart payload, to create a pinch hazard
between the payload and the HMI post.

CAUTION: PINCH RISK
Ensure that there is enough space between the HMI post and your payload,
when the transporter and cart are coupling, so that it is not a pinch hazard.

Weight

Run-time between charges is a function of payload weight. A heavier payload will result in a
shorter run-time. If you have added any options to the platform that draw power from the plat-
form battery, that will also result in decreased run-time.

Center of Gravity

When adding payload, the center of gravity of the entire cart and payload needs to be con-
sidered.

As much as possible, you should keep the payload center of gravity centered on the platform,
and as low (close to the platform top) as possible. This will give you the best stability, par-
ticularly when turning or crossing irregularities in the floor.

The payload should be centered on the cart left-to-right, but biased toward the rear of the cart
according to the following plots.

The following figures show the calculations of safe placements for the center of gravity for pay-
loads with the weights listed. The center of gravity, in each instance, needs to be within the
area shown. All units are mm.

IMPORTANT: These figures show centers of gravity for the listed parameter set-

tings only. They do not apply to any other parameter settings. Even small
changes in these parameters can change the safe CG area drastically.
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105 kg

Figure 5-1. Isometric View, 105 kg, (A) Vertical Direction, (B) Longitudinal Direction, (C) Transverse
Direction (units in mm)

Figure 5-2. Longitudinal View, 105 kg, (A) Vertical Direction, (B) Longitudinal Direction (units in
mm)
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©

Figure 5-3. Transverse View, 105 kg, (A) Vertical Direction, (C) Transverse Direction (units in mm)

©

Figure 5-4. Top View, 105 kg, (B) Longitudinal Direction, (C) Transverse Direction (units in mm)
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130 kg

©

Figure 5-5. Isometric View, 130 kg, (A) Vertical Direction, (B) Longitudinal Direction, (C) Transverse
Direction (units in mm)

Figure 5-6. Longitudinal View, 130 kg, (A) Vertical Direction, (B) Longitudinal Direction (units in
mm)
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©

Figure 5-7. Transverse View, 130 kg, (A) Vertical Direction, (C) Transverse Direction (units in mm)

©

Figure 5-8. Top View, 130 kg, (B) Longitudinal Direction, (C) Transverse Direction (units in mm)
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5.3 Payload-Related Tradeoffs

If you have to extend your center of gravity beyond the guidelines given here, you will need to
adjust various parameters in the MobilePlanner software to compensate for that.

Contact your local Omron support to get a new set of plots based on parameters that differ
from those used to produce the plots shown here.

In general, lowering the maximum accel, decel, and rotation speeds will be required. Refer to
Acceleration, Deceleration, and Rotation Limits on page 73.
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Most of the connections that are available to the user are in the payload bay, which is the
space between the platform and the platform top plate. These include I/O and power con-
nections. Access to the payload bay is covered in Accessing the Payload Bay on page 156.

For a LD Platform Cart Transporter system, most of these connections will not usually be used.

The two connections outside of the payload bay are the Joystick port and the Maintenance Eth-
ernet port, which are located under a small access panel on the left side of the platform, in the
upper-right corner. Both of these ports connect to the core inside the payload bay.

6.1 Required Connections

« Joystick port

« Maintenance
Ethernet

o Wireless
Ethernet

o Docking
Station

In order to generate maps with the LD Platform Cart Transporter, you
need to connect a joystick to its Joystick port.

The Joystick port is located under a small access panel on the left side
of the platform, in the upper-right corner.

The Maintenance Ethernet port is located under a small access panel
on the left side of the platform, in the upper-right corner.

Its IP address is 1.2.3.4, with Netmask 255.255.255.0.
Access to the SetNetGo OS is always enabled on this interface, and
does not require a password or a license.

For multi-AIV installations, or where you wish to send new com-
mands or receive status updates from the AIV, you need to have wire-
less Ethernet.

The AIV needs access to a docking station so it can charge itself. The
docking station needs access to AC power.

6.2 LD Platform Cart Transporter Connections

NOTE: All of these are in the payload bay.

NOTE: If a connection is covered in this subsection, it means that the descrip-
tion in the subsection Standard Platform Connections on page 89 does not apply
to the LD Platform Cart Transporter, because that connection is being used for a
cart-specific use.

Core

o RS5232-2 is used for the rear-sensing laser.

» Both the Debug Port and Aux Power are used by the coupling laser.

« Digital I/O connector.
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The transporter uses pins 9-16, both Input and Output.
Pins 1-8 are available on the cart PCA.

o User Power is used for cart PCA power.

o User Interface goes through the PCA to the Operator panel.

o Aux Sensors is used for both side lasers and the low front laser.
o Light Pole goes through the PCA to the Operator panel.

o User LAN goes to the Ethernet switch in the payload bay. Two ports are spares.

Cart-Specific PCA

NOTE: Contact your local Omron support for details.
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Figure 6-1. PCA Silkscreen with Callouts
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Callout Description Callout Description
A User Beeper Out E UserI/O Out 1-8
B User EMO Out UserI/O1In 1-8
C User EMO Switch Connector G User Power Out
D User Power

User E_Stop (USER EMO OUT), J13. Micro MATE-N-LOK, mates with TE 6C 794617-6.

Pin No. Designation Notes

1 ESTOP 2A Dry contact

2 ESTOP 2B Dry contact

3 BRAKE Use switch to connect to BATTERY (pin 5)
for external brake release

4 ESTOP CTRLD POWER | (BAT) 1 Alimit

5 BATTERY 1 Alimit

6 GND

User E-Stop Switch (USER EMO SWITCH), J39. Jumpers JP40 and JP41 must be moved to pins
1-2 for this to be functional. MiniFit Jr™, mates with MOLEX 4C 39-01-2045.

Pin No. | Designation | Notes
1 ESTOP 1A
2 ESTOP 2A
3 ESTOP 1B
4 ESTOP 2B

User Power, J15 & J16. MiniFit Jr™, mates with MOLEX 6C 39-01-2065.

User Power, ]37. Jumper JP5 selects battery (1/2) or E-Stop-controlled battery (2/3).

Pin No. | Designation Notes
1 GND
2 GND
3 GND
4 5V 2 Atotal
5 12V 1.5 Atotal
6 BATTERY 22-28V
1 A total

MiniFit Jr™, mates with MOLEX 4C 39-01-2045.
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User 1/O Outputs, J19 - J26. Micro MATE-N-LOK, mates with TE 2C 794617-2.

The return is common for each bank of four outputs, with the indicated jumper.

86

Pin No. | Designation | Notes
1 BATTERY 1.8A
2 GND

3 N.C.

4 SHIELD GND

Connector | Designation Notes
J19 OouT1 JP13,LED DS14
J20 ouT2 JP11,LED DS15
J21 OuUT3 JP10, LED DS16
J22 ouT4 JP12,LED DS17
P26 RETURN Selects HI or LO for J19-122
123 OuUT5 JP17,LED DS10
J24 ouT6 JP15, LED DS11
J25 ouT7 JP14,LED DS12
126 ouT8 JP16,LED DS13
P27 RETURN Selects HI or LO for J23-126
Pin No. | Designation Notes
1 RETURN 0 or Battery, 22-29 VDC
2 OUTPUT HI (BAT) or LO (GND)
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Figure 6-2. Output Schematic
Callout Description Callout | Description
A Output High Side Drivers B Set JP26 and 27 to 2/3 for Active

High Out

Set remaining Jumpers to 2/3 for
Active Low Out

User 1/O Inputs, J40, J45 - J51. Micro MATE-N-LOK, mates with TE 4C 794617-4.

The return is common for each bank of four inputs, with the indicated jumper.

Connector | Designation Notes
J40 IN1 LED DS26
J45 IN2 LED DS27
147 IN3 LED DS29
J46 IN4 LED DS28
JP6 RETURN Selects SINK LO or SOURCE HI
for 340, J45-47
J51 INS LED DS33
J50 ING6 LED DS32
J49 IN7 LED DS31
148 IN8 LED DS30
JP7 RETURN Selects SINK LO or SOURCE HI for J48 - 351
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Pin No. | Designation Notes
1 BATTERY 22-29VDC, 0.4 ATOTAL
2 GND HI (BAT) or LO (GND)
3 SENSOR
4 SHIELD GND
.09K P6 i%.
DS26
340 N
T N 10_INPUTL
IN_1 (—ZJ% | l\/\é\éK
< 7 Ds27 m’%
195 1 M \\ 3K PS2805_4
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Hi}:\ELDfGN'D
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e, T
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J51 . \\DSSS
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(‘;ﬁauﬁmb
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J48 ] vesg \\ DS30
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Figure 6-3. Input Schematic
Callout Description Callout Description
A Jumpers shown as ACTIVE LOW IN Cc INPUTS 9-16 Have
options for PIC outputs
Move to 2/3 position ACTIVE HIGH P P
IN
B INPUTS 1-8 Targeted for ACTIVE
LOW IN, 9-16 for ACTIVE HIGH IN.
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User Beeper, J56. Micro MATE-N-LOK, mates with TE 2C 794617-2.

This signal goes low when the platform is moving. It can be used to drive a beeper.

Pin No. | Designation Notes
1 BATTERY 22-29VDC,0.1 A
2 SOUNDER ACTIVE LOW

6.3 Standard Platform Connections

NOTE: All of these are in the payload bay.

If there is no conflicting connection in the Connectivity on page 83, these connections are avail-
able for use with standard- and user-supplied accessories. The antennas and joystick come
with the platform.

NOTE: If a connection is in Connectivity on page 83, it means that the descrip-
tion here does not apply to the LD Platform Cart Transporter, because that con-
nection is being used for a cart-specific use.

NOTE: Standard connectors, such as audio, are not covered here. These are on
the right side of the core, shown in the following figure:

™\

-

Digital Antl Ant2
Audio Out

Audio In  Audio Out

Uiy

Figure 6-4. Right Side of the Core

The left end of the LD Platform core has 12 indicator lights. Their meanings are covered in LD
Platform Core Indicators on page 128.
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LD Platform Core Front, Upper

o\
\

Aux Sensors

RS232-2

armn

Q=)o
AnalogO ‘

I

RS232-1

|
User LAN

Figure 6-5. Front Upper Core

Connection Type Description

User LAN R145, General Ethernet, Auto-MDIX.

Shielded

Aux Sensors HDB15M [ Side lasers

RS-232x2 DB9M Port 1 and Port 2, general use

CAN Bus B DB9F Consult Support for use.

Digital I/O (HDB44F) HDB44F | 16 digital inputs, in 4 banks of 4. Each bank can be
wired as active high or active low depending on the
connection of the BANK# terminal.

Vn range for each input is 0 to 30 V. The input is ON
when Vi > 4V, OFF when Vi < 1.3 V.
16 digital outputs, protected low-side drivers. These
outputs should be wired to positive voltage through
the load. Output is open when OFF and grounded
when ON. Each open-drain output is capable of sink-
ing 500 mA. May be used with loads connected to
VBAT, AUX_20V, _12V, or _5V. You must stay
within the allowed current capacity of the VBAT or
AUX power supplies.
Analog I/O HDB15M [ General use
CAN Bus B
Connectortype DB9F
Use CAN Bus
Pin No. Designation Notes
1,4,8 No Connection
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Pin No. Designation Notes

2 CANL_B CAN Communication differential pair
3,6 GND Direct GND

5 SHIELD GND Bead filter to GND

7 CANH_B CAN Communication differential pair
9 CANB_12V_OUT_SW | 12V @ 0.5 A Max (switched in SW)

Digital I/0

Connectortype HDB44F

Designation
Pin No. Hardware Software Notes
1 INPUT_1.1 Input_1.1 | 0-30 VRange, R;,, = ~3.9 kQ
2 INPUT_1.2 Input_1.2 | 0-30 VRange, Rj, = ~3.9 kQ
3 INPUT_1.3 Input_1.3 | 0-30 VRange, Ri,, = ~3.9 kQ
4 INPUT_1.4 Input_1.4 | 0-30 VRange, R;, = ~3.9 kQ
5 BANK1 Common for INPUT_1.X
6 INPUT_2.1 Input_2.1 | 0-30 VRange, Rj, = ~3.9 kQ
7 INPUT_2.2 Input_2.2 | 0-30 VRange, Ri,, = ~3.9 kQ
8 INPUT_2.3 Input_2.3 | 0-30 V Range, Rj, = ~3.9 kQ
9 INPUT_2.4 Input_2.4 | 0-30 VRange, R;, = ~3.9 kQ
10 BANK2 Common for INPUT_2.X
11 INPUT_3.1 Input_3.1 | 0-30 VRange, R, = ~3.9 kQ
12 INPUT_3.2 Input_3.2 | 0-30 VRange, R;,, = ~3.9 kQ
13 INPUT_3.3 Input_3.3 | 0-30 VRange, R;,, = ~3.9 kQ
14 INPUT_3.4 Input_3.4 | 0-30 VRange, R;, = ~3.9 kQ
15 BANK3 Common for INPUT_3.X
16 INPUT_4.1 Input_4.1 | 0-30 VRange, R;,, = ~3.9 kQ
17 INPUT_4.2 Input_4.2 | 0-30 V Range, R;,, = ~3.9 kQ
18 INPUT_4.3 Input_4.3 | 0-30 VRange, Rj, = ~3.9 kQ
19 INPUT_4.4 Input_4.4 | 0-30 VRange, Ri,, = ~3.9 kQ
20 BANK4 Common for INPUT_4.X
21 OUTPUT_1 Output_1
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Designation

Digital Input Specifications

92

Pin No. Hardware Software Notes
22 OUTPUT_2 Output_2
23 OUTPUT_3 Output_3
24 OUTPUT_4 Output_4
25 OUTPUT_5 Output_5
26 OUTPUT_6 Output_6
27 OUTPUT_7 Output_7
28 OUTPUT_8 Output_8
29 OUTPUT_9 Output_9
30 OUTPUT_10 Output_10
31 OUTPUT_11 Output_11
32 OUTPUT_12 Output_12
33 OUTPUT_13 Output_13
34 OUTPUT_14 Output_14
35 OUTPUT_15 Output_15
36 OUTPUT_16 Output_16
37 VBAT_IO_OUT4 VBAT @ 0.5 A Max
(shared with light pole)
38 VBAT_IO_OUT3 VBAT @ 0.5 A Max
39 VBAT_IO_OUT2 VBAT @ 0.5 A Max
40 VBAT_IO_OUT1 VBAT @ 0.5 A Max
41,42, | GND
43,44
Parameter Value
Operational voltage range | 0 to 30 VDC
OFF state voltage range O0to1.3VDC
ON state voltage range 4 to30VDC
Operational current range | 0 to 7.5 mA
OFF state current range Oto0.5mA
ON state current range 1.0to7.5mA
Impedance (V; /1) 3.9 kQ minimum
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Parameter Value

Currentat V;, = +24 VDC | [, < 6 mA

in =

NOTE: The input current specifications are provided for reference. Voltage
sources are typically used to drive the inputs.

Figure 6-6. Typical Digital Input Wiring Example

Callout Description Callout Description

A Supplied Equipment H Input Bank 1

B User-Supplied Equipment J Input Bank 2

C Wiring Terminal Block K Input Bank 3

D Typical User Input Signal L Input Bank 4

E Part Present Sensor M Note: all input signals can be used
for either sinking or sourcing con-
figurations.
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Callout

Description

Callout

Description

F

Bank 1 configured for sinking
(NPN) inputs

N

Equivalent Circuit

G Bank 4 configured for sinking
(PNP) inputs
Table 6-1. Digital Output Specifications
Parameter Value
Power supply voltage range 5-30 VDC
Operational current range, per channel | I, < 500 mA
ON state resistance (I, = 0.5 A) Ron £0.14 Q @ 85°C
Output leakage current Lot S5 HA
DC short circuit current limit 0.7A<I v=1.7A
Figure 6-7. Typical Digital Output Wiring Example
Callout Description Callout Description
A Standard Equipment E Load
B User-Supplied Equipment F Outputs 1-16
C Wiring Terminal Block G Equivalent Circuit
D Typical User Loads
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Analog I/0

Connector type HDB15M

Pin No. Designation Notes

1 ANALOG_IN1 0-10 V Range
2 ANALOG_IN2 0-10 VRange
3 ANALOG_IN3 0-10 VRange
4 ANALOG_IN4 0-10 V Range
5 ANALOG_IN5 0-30 V Range
6 ANALOG_IN6 0-30 V Range
7 ANALOG_IN7 0-30 VRange
8 ANALOG_INS8 0-30 V Range
9 ANALOG_OUT1 | 0-20 V Range
10 ANALOG_OUT2 | 0-20 V Range
11 ANALOG_OUT3 | 0-20 V Range
12 ANALOG_OUT4 | 0-20 V Range
13,14,15 | GND

Chapter 6: Connectivity

o The 0-10 V analog inputs have an input impedance of about 35 kQ.

o The 0-30 V analog inputs have an input impedance of about 110 k(.

» The analog outputs have an output impedance of about 200 Q.

The maximum output current of each analog output is 10 mA. Exceeding the maximum
output current will result in damage to the analog output module.

Aux Sensors

Connectortype HDB15M

Use Side (vertical) and low sensing (foot) lasers
Designation
Pin No. Hardware Software Notes
1 RS232_VERT1_TXD /dev/ttyUSB5
2 RS232_VERT2_TXD /dev/ttyUSB6
3 RS232_FOOT_TXD /dev/ttyUSB7
4 5V_Swi USB_1_and_2_Power |5V @ 1 A (shared with USB port 1)
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Designation
Pin No. Hardware Software Notes
5,10 SW_20V_VERT Vertical_Laser_Power | 20V @ 300 mA
6,7,8 |GND
9 5V_Sw?2 USB_1_and_2_Power |5V @ 1 A (shared with USB port 2)
11 RS232_VERT1_RXD /dev/ttyUSB5
12 RS232_VERT2_RXD /dev/ttyUSB6
13 RS232_FOOT_RXD /dev/ttyUSB7
14 5V_SW3 USB_3_Power 5V @ 1 A (shared with USB port 3)
15 SW_20V_FOOT Foot_Laser Power 20V@ 150 mA
RS232 1 &2
Connectortype DB9M
Use Port 1 and 2, General Use
Pin No Designation Notes
1,4,6,9 | NoConnection
2 RS232_USR#_RXD | #=1o0r2
3 RS232_USR#_TXD | #=1o0r2
5 GND
7 RS232_USR#_RTS | #=1o0r2
8 RS232_USR#_CTS | #=1o0r2

T |
__ —
ojofo ofjoyojojo|ojo
oj)ojo ojojojojojlojo
N\ N/ N\
=

©)

IR
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NOTE: The connectors in the top row of the Rear Upper Core mate with Molex

Mini-Fit Jr™ 5557 series receptacles.

Callout | Connection Type Description
A Light Pole Mini-Fit 2 x 3 Connects to a user-supplied light tower with 3
lights and 1 buzzer, using a default configuration
NOTE: The following four functions are pins on the User Interface connector.
B Brake- Mini-Fit2 x 7 Pins for user-supplied brake release
release
ON Pins for user-supplied ON button
OFF Pins for user-supplied OFF button
ESTOP Pins for user-supplied E-Stop (must be used or
jumpered)
C User Mini-Fit This connection is not used with an LD Platform
Bumpers 2x4 Cart Transporter.
D Aux Power Mini-Fit 5,12, and 20 VDC Outputs
2x3
E User Power | Mini-Fit Battery and switched battery power
2X6
] Maint LAN R145, Directly connected to the externally-mounted
Shielded Maintenance Ethernet, Auto-MDIX.
H Joystick DB9F Directly connected to the externally-mounted
Joystick port
G HMI Panel HDB15F Operator screen, E-Stop, Brake_Rel, ON, OFF
F Sonar 2 DB9M This connection is not used with an LD Platform
Cart Transporter.

Power Connections

The platform provides conditioned 5, 12, and 20 VDC, and raw (battery) 22 - 30 VDC power to
the platform’s and accessory electronics, including the onboard LD Platform core and safety
scanning laser LIDAR (Light Detection And Ranging).

All power connectors are Mini-Fit®.

14766-000 Rev G

Nominal Qty Actual Mg::_':_:’:: Description
5VDC 1 5+5% VDC 1A Switched Aux power
12 VvDC 1 12+5% VDC 1A Switched Aux power
20 VvDC 1 20+5% VDC 1A Switched Aux power
22 -30VDC 2 battery 4 A Switched

LD Platform Cart Transporter User's Guide
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Nominal Qty Actual Mg:i-Tel;T Description
22 -30VDC 1* battery 10A Switched
22 -30VDC 1% battery 10A Safe, Switched
* 10 A Switched and 10 A Safe, Switched share the 10 A of current.

Each supply has an associated LED, which, when lit, indicates that the port is actively

powered. See LD Platform Core Indicators on page 128.

The Safe 22 - 30 VDC supply automatically gets disconnected when the E-Stop button is

pressed or an obstacle is detected.

Light Pole

Connector type  Mini-Fit® 3 x 2

Use Light tower (user-supplied)
Pin No. | Designation Notes
1 GND Cable shield
2 LIGHT_P1 Red
3 LIGHT P2 Yellow or orange
4 VBAT_IO_OUT4 | VBAT @ 0.5A Max (shared with DIO)
5 LIGHT_P3 Green
6 LIGHT_P4 Buzzer

®

Figure 6-9. Sample Light Pole Diagram
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Callout Description Callout Description
A Standard Equipment D Typical User Load
B Wiring Terminal Block E Equivalent Circuit
C User-Supplied Equipment

User Interface

Connector type Mini-Fit® 7 x 2

Use Brake release, ON, OFF, E-Stop

Pin No.| Designation Notes

1,2,3 | FBAT_ALWAYS |Fused VBAT @ 500 mA

4 ESTOP_USR_1L | Short4 & 11 to close ESTOP_USR_1

5 ESTOP_USR_2L | Short 5 & 12 to close ESTOP_USR_2

6 ESTOP_OUT_1L [ Pins 6 & 13 short when ESTOP_CH1 is closed

7 ESTOP_OUT_2L | Pins 7 & 14 short when ESTOP_CH?2 is closed

8 OFF_BUTTON Short to FBAT_ALWAYS to signal OFF (min 1 s pulse)
9 START_BUTTON | Short to FBAT_ALWAYS to signal ON (min 1 s pulse)
10 MOTOR_BRAKE | Short to FBAT_ALWAYS for manual brake release
11 ESTOP_USR_1H | Short 4 & 11 to close ESTOP_USR_1

12 ESTOP_USR_2H | Short 5 & 12 to close ESTOP_USR_2

13 ESTOP_OUT _1H | Pins 6 & 13 short when ESTOP_CH1 is closed

14 ESTOP_OUT_2H | Pins 7 & 14 short when ESTOP_CH?2 is closed

NOTE: An E-Stop jumper or a user-supplied E-Stop button needs to be attached
to the E-STOP port on the User Interface connector for the platform to function.
The jumper is provided as part number 12730-000L. An E-Stop button would be
user-supplied.

NOTE: Engaging the E-Stop through the external connector or Operator Panel
(faster than 250 ms), will cause motors to re-engage after E-stop is released.
Motor re-engagement occurs because the core is designed to receive a consistent
E-Stop signal for at least 250 ms. Signals that engage and disengage in a time
period shorter than 250 ms, will cause LD to assume that the change was due to
a bumper press, which will automatically re-engage the motors. No signal on the
E-Stop chain can cause the robot to operate while the E-Stop remains engaged.
Thus it is necessary to leave the E-Stop engaged, if the intent is to keep the robot
in a E-Stop state.
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CAUTION: PERSONAL INJURY OR PROPERTY DAMAGE RISK

If you are using a user-supplied E-Stop, you must run the Safety Com-
missioning to verify the E-Stop’s functionality before putting the AIV into ser-
vice.

NOTE: See the following figure.

Figure 6-10. E-Stop Jumper on Platform Core
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© ©

(ESTOP_FP_1H)

(ESTOP_FP_2H)

®

ESTOP_FP_1L

(ESTOP_USR_1H)

ESTOP_FP_2L

(ESTOP_USR_2H)

®

ESTOP_USR_1L ESTOP_USR_2L
(BMP_L1H) P (BMP_R2H) ®
BMP_L1L BMP_R2L @
b
(BMP_R1H) 1 (BMP_L2H)
BMP_RI1L BMP_L2L
(ESTOP_CH1) (ESTOP_CH2)
LIDAR_OSSD1 JOY_EN1H
LIDAR_OSSD2 JOY_EN2L
f'___'___l f'___'___l
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© - — - O
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Figure 6-11. E-Stop Chain Diagram
Callout Description Callout Description
A Standard Circuits H Bumper Right

User-Supplied Circuits

J E-STOP Relay Control Logic

E-STOP-Source

K Voltage of the Battery

B
C
D

Ground

High Power to Amplifiers

14766-000 Rev G
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6.3 Standard Platform Connections

Callout Description Callout Description
E Front Panel E-STOP M HMI Connector
F User E-STOP N Note: Jumper closed when not
used, MUST open both channels
independently if used.
G Bumper Left @) User Interface Connector
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User Bumper

Chapter 6: Connectivity

This connection is not used with an LD Platform Cart Transporter.

Aux Power

Connector type  Mini-Fit® 3 x 2

Designation

Pin No. Hardware | Software Notes

1,2,3 |GND

4 AUX_5V_OUT | Aux_5V 5V@1Amax

5 AUX_12V_OUT [ Aux_12V |12V @ 1 Amax

6 AUX_20V_OUT | Aux_20V [20V @ 1 Amax

User Power
Connector type Mini-Fit® 6 x 2
Designation
Pin No. Hardware Software Notes
1,2, GND
3,4,
5,6
7 SW_VBAT_OUT1 | Battery_Out_1 VBAT @ 4 A max (switched in SW)
8 SW_VBAT_OUT2 | Battery_Out_2 VBAT @ 4 A max (switched in SW)
9,10%* SW_VBAT_OUT34 | Battery_Out_3_and_4 | VBAT @ 10 A max (switched in SW).
Limit to < 5 A per pin.
11,12* | SAFE_VBAT_OUT SW_VBAT_OUT34 gated by
dual-channel ESTOP relays.

*9,10,11,and 12 sharethe 10 A of current.

Joystick

Connector type DBOSF

Use

14766-000 Rev G

Joystick
Pin No. | Designation Notes
1 JOY_XAXIS Analog X input
2 JOY_YAXIS Analog Y input
3 JOY_SPEED Analog SPEED input

LD Platform Cart Transporter User's Guide
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HMI Panel

Pin No. | Designation Notes

4 JOY_GOAL Goal Button Input
5 JOY_EN_1H Enable channel 1
6 JOY_EN_2L Enable channel 2
7 No Connection

8 GND

9 5V 5V@ 100 mA

Connectortype HDB15F

Use Operator screen, E-Stop, Brake_Rel, ON, OFF
NOTE: The HMI panel that this connects to is not the touchscreen used for the
LD Platform Cart Transporter. The HMI panel is not used with the LD Platform
Cart Transporter, so this connector is not used.
Designation
Pin No. Hardware Software Notes
1 RS422_HMI_TX+
2 RS422_HMI_TX-
3 MOTOR_BRAKE
4,5 ESTOP_FP_1H, _2H
6 RS422_ HMI_RX+
7 RS422 HMI RX- Connections to HMI Panel
8 START BUTTON NOTE: This is not the touch-
— screen.
9,10 ESTOP_FP_1L,_2L
11 HMI_5V_SW HMI_Power
12,14 |GND
13 OFF_BUTTON
15 FBAT_ALWAYS
Sonar 1 & 2

This connection is not used with a cart.

NOTE: Sonar 1 is part of the Internal Core connections.
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Internal LD Platform Core Connections

The following connections are internal (under the platform's top deck), and not normally avail-
able for the user. They are listed here so that you can reconnect them in the event that they

need to be disconnected for parts replacement.

Figure 6-12. Internal Connectors on the LD Platform Core (Front)

NOTE: The Bumper, Speakers, and Batt Comm. connectors on the internal core
mate with Molex Mini-Fit Jr™ 5557 series receptacles.

NOTE: The Charge Contacts and Battery Power connectors on the internal core
mate with Molex Mini-Fit Jr™ 42818 series receptacles.

Callout | Connection Type Description
A Debug RS- DB9M Reserved
232
B Wheel Lights | DB9F Motion and status indicator
Light Discs on the platform sides
C Sonar 1, DBOM Connection to Sonar Module
RS-422 (Rear sonar sensors)
D Charge Mini-Fit Sr.,
Contacts 2-pin

14766-000 Rev G
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Callout | Connection Type Description
E VGA HDB15F Reserved
F USBx 3 USB Type A Reserved
G LIDAR HDB26M Safety Scanning Laser
H Right Motor HDB26F NOTE:The Right and Left Motor connectors use
the same type of plug. Take care not to reverse
] Left Motor HDB26F them.
K Battery Power | Mini-Fit Sr., Battery VDC; connects to battery
3-pin
L Bumper Mini-Fit 2 x4 | This connection is not used with a LD Platform Cart
Switches Transporter.
M Speakers Mini-Fit 2 x 2 | Drives built-in speakers
N Battery Mini-Fit 2 x 3 | Battery communication/control
Comm.

Core Internal Data Pinouts

Wheel Lights (Light Discs)

Connector type DB9F

Use Motion and status indicator Light Discs on the platform sides
Designation
Pin No. Hardware Software Notes
1,2 CANL_A CAN Communication differential pair
3,4 GND Direct GND
5 SHIELD GND Bead filter to GND
6,7 CANH_A CAN Communication differential pair
8,9 SW_12V_WHEEL | WheelLight_Power [ 12V @ 1 A Max (switched in SW)
NOTE: Sonar 1 is covered at the end of Core, Upper Rear.
106 LD Platform Cart Transporter User's Guide
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LIDAR (Light Detection And Ranging)

Connector type DB26M

Use Front safety scanning laser

Designation

Pin No. Hardware Software Notes

—

RS422_LIDAR_RX+

RS422_LIDAR_RX-

0SsD1

0SsD2

WF_OUT

0O3_0ouT

STANDBY

EDM

Ol [(IN|[J]oojUwun |~ |[W]|N

No Connection

Connections to

10,18 SW_20V_LIDAR Main_Laser_Power Factory-Supplied LIDAR

11 thru17 | GND

19 RS422_LIDAR_TX+
20 RS422_LIDAR_TX-
21 IN_A1
22 IN_A2
23 IN_B1
24 IN_B2
25 IN_C1
26 IN_C2

Pin 10 + 18: Current < 600 mA
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LD Platform Core Internal Power Pinouts

Bumper
Connection Mini-Fit® 4 x 2
Connector type DBOF

Use Front bumpers

NOTE: The single front bumper uses four sensors for operation.

Pin No. | Designation Notes

1 BUMPER_R2L | Right, Channel 2, Low

BUMPER_R1L | Right, Channel 1, Low

BUMPER_L2L | Left, Channel 2, Low

BUMPER_L1L | Left, Channel 1, Low

BUMPER_R2H | Right, Channel 2, High

BUMPER_R1H | Right, Channel 1, High

BUMPER_L2H | Left, Channel 2, High

O |IN|IOO|Un | P~ W]|N

BUMPER_L1H | Left, Channel 1, High

Speakers

Connector type  Mini-Fit® 2 x 2

Use Speakers
Pin No. | Designation Notes
1 RIGHT+
Right Speaker
2 RIGHT-
3 LEFT+
Left Speaker
4 LEFT-
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Batt Comm.

Connector type  Mini-Fit® 3 x 2

Use Battery control
Pin No. Designation Notes
1 GND
2 RS232_BATT_RXD
3 RS232_BATT_TXD | connections to the
4 FBAT ALWAYS Factory-Supplied Battery
5 START_BUTTON
6 OFF_BUTTON

14766-000 Rev G LD Platform Cart Transporter User's Guide 109






Chapter 7: Operator Interface

The Operator panel comprises a touchscreen, an E-Stop button, ON and OFF buttons, a brake-
release (BRAKE) button, a keyswitch, and LATCH and UNLATCH buttons. The panel is moun-
ted on the HMI post, so that it is easily reached by an Operator.

Figure 7-1. Operator Panel, with Acuity Option Shown

7.1 Touchscreen

Touchscreen Initialization
When first powered up, the bottom of the touchscreen will display its boot status.

1. Initializing robot core connection...
NOTE: This may take a minute or two to initialize.

2. Initializing touchscreen software...
3. Connecting to the robot core...

4. Downloading data from the robot core...
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7.1 Touchscreen

Figure 7-2. Screen Initialization Status Display

After initialization, either the Choose Dropoff or Patrol Route screen will be displayed.

Touchscreen Configuration
The behavior of the touchscreen is highly configurable. See Configuring a Touchscreen on page
66.

Screen Top Bar

The top of the screen shows basic AIV information. This includes a bar graph indicating the
WiFi signal strength, the name of the AIV, and the battery state of charge. If the AIV is con-
nected to an Enterprise Manager, it will also be specified here.

Left Screen Pane

The screen logo is displayed in the upper part of the left pane. This doesn’t change, regardless
of the mode you are in. See Screen Logo on page 70.

Below the screen logo, the AIV status is displayed, first graphically, and below that, in text.
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Figure 7-3. Screenshot Showing Top Bar and Left, Right, and Center Panes

Figure 7-4. LD Platform Cart Transporter Status Icons

NOTE: The Busy icon may also include an arrow pointing down, indicating a
pickup, an arrow pointing up, indicating it is doing a dropoff, or an exclamation
mark, indicating an alert condition. Figure 7-3. shows a dropoft.

The bottom of the left side of the touchscreen provides a Stay button, to delay the departure of
the AIV, and a count-down timer, indicating when the AIV will depart.
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Each touch of the Stay button adds 1 minute to the time the AIV will wait before continuing to
its next goal.

« If you touch Stay while the AIV is stopped, it will add 1 minute to the time the AIV is
scheduled to wait before continuing to its next goal.

« If you touch Stay while the AIV is moving, it will stop, and stay for 1 minute.

NOTE: The Stay count-down timer can be zeroed at any time by touching Go at
the bottom of the center pane.

The screensaver can be set up to behave the same way the Stay button does, so that touching
the screensaver adds 1 minute to the time the AIV will wait. See Screensaver on page 71.

Right Screen Pane

The right side of the touchscreen displays Home, Dropoffs, Status, and Help tabs. touching one
of these tabs changes the context of the center pane.

Home Tab

NOTE: The Dropoffs tab is not displayed in Patrol Route mode.

The Home tab is used to switch the center pane to show the AIV’s current mission. If an error
condition exists, such as the AIV overheating or being lost, the software will automatically
select the Home tab. See the following figure.

Figure 7-5. Payload Alert, Displayed from the Home Tab

The preceding screen will not be displayed unless the configuration has been set up in the
MobilePlanner software:

Config > Robot Physical > Payload > NumSlots

This must be set to a non-zero value, i.e. the number of payload slots.
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Config > Robot Interface > Payload Present Messages and Behavior
o The AlertWhenPayloadNeededForDropoff must be checked.

« The PayloadNeededForDropoffShortDescription must have a value. In this case, the
value is “Payload Needed”, which is displayed in the screen’s left pane.

o The PayloadNeededForDropoffLongDescription must have a value. In this case, the
value is “The robot has a destination but does not have a payload. Please load an item
or cancel the dropoff.” This will be displayed in the screen’s center pane.

NOTE: The payload parameter section will not be displayed unless the
payload slots at the top of the Payload Present Messages and Behavior are
set to a non-zero value.

The Home screen also has an entry for relocalizing a lost AIV from the touchscreen. See Relo-
calization on page 118.

When you select Home from the right pane tabs (rather than when the software switches to
Home), the center pane will display information about the AIV's current mission, such as the
job details or the current route task.

Dropoffs Tab - Choose Dropoff mode only

Dropoffs shows the available goals, giving the Operator the ability to choose the next goals,
and shows the status of the AIV with respect to the goals it has been assigned.

In Patrol mode, this option isn’t displayed.

Status Tab

After touching the Status tab, you will be given a choice of either Alerts, Robot, I/O, or Peri-
pherals (which accesses screen-cleaning mode).

The number of alert messages that are available for viewing is indicated by a number in a red
circle on the Status button. See the preceding figure.

Figure 7-6. Status Tab and Sub-menu
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o Alerts shows an abbreviated list of all active alert messages.
Touching on a specific message will display that full message.
¢ Robot shows AIV status, such as the IP address, current task, and its mode.

Position Details, within the Robot Status screen, shows the AIV’s position, heading, velo-
city, and localization score.

« I/O will display any of the Core Digital Inputs / Outputs that have been configured as a
“custom” type

Figure 7-7. Status > 1/O Screen (Top Inputs are not shown in this example)
o Peripherals > Touchscreen allows you to lock the touchscreen, so that you can clean the

screen without it interpreting that as input. The screen stays locked for one minute, and
then returns to normal function.

Help Tab

Help shows information on the installed software and contact information.

NOTE: No contact information will be displayed unless it is set up in the
MobilePlanner software. See Contact Information on page 73.
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Figure 7-8. Help > Contact Information
Help also provides access the Replay Recorder page.

Replay Recorder

The replay recorder will record data for troubleshooting. Once the start page is opened, you
just touch Start. When you are done recording, touch Stop. The Duration and Replay File fields
are filled in by the recorder. After the recording is completed, use the MobilePlanner software
to download the file generated.

Figure 7-9. Replay Recorder Start Page
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Fiqure 7-10. Replay Recorder, After Touching Stop

Center Pane

The content of the center pane changes depending on what has been selected from the right
pane. The bottom of the center pane will almost always have a Go button, to zero the Stay
count-down timer, and tell the AIV to proceed to its next goal.

Relocalization

The touchscreen gives you a way to relocalize the AIV if it becomes lost. Before you can do
that, you need to have set up at least one localization goal, with a heading, at which the AIV
can localize. You can set up multiple such goals, if you like. See Localization Goals on page
69.

If the AIV becomes lost, the touchscreen will automatically select the Home tab (from the right
pane), and display a message indicating that the AIV is lost. It will also offer an option to
Recover.

1. Touch Recover.
2. Follow the on-screen instructions.
You will be instructed to manually move the AIV to a localization goal, and then tell
the software which goal you moved the AIV to.
Choose Dropoff Mode

In this mode, the touchscreen communicates with the queuing manager, which then com-
municates with the AIV.
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Dropoffs

NOTE: Until the queuing manager has been enabled, the touchscreen will not
display any of the dropoff goal buttons. Refer to the Mobile Robot Software Suite
User’s Guide.

In this mode, the center of the screen displays touch-sensitive dropoff buttons, indicating the
goals associated with them. If there are more buttons than can be displayed at once, a sliver of
the adjacent row of buttons is shown, to indicate their existence. See Screenshot Showing Top
Bar and Left, Right, and Center Panes on page 113.

Navigation of the center pane, when there are more buttons than can be displayed at one time,
is done by touching the screen, between buttons, and dragging the pane up or down.

The color and border of a dropoff button indicate the status of the associated job.

Status Color Border Cancel Priority
Ready Blue None n/a n/a
Planned Dark Blue None Yes Yes
Requested Dark Blue None Yes Yes
Pending Dark Blue Med. Blue Yes Yes
In progress Dark Blue Green Yes No
Interrupted Dark Blue Orange Yes No
Completed/Canceled Blue None n/a n/a

The Operator can use this pane for entering the goals where they want the AIV to go for
dropoffs, after leaving its current location.

Touching a dropoff button and then Go requests that the AIV be sent to that goal. Touching
several buttons in sequence, followed by touching Go, requests that the AIV be sent to all of
those goals, in the order in which the dropoff buttons were touched. The order may be altered
by assigning high-priority to any of the goals.

The number of buttons, the content of each button, and the goal associated with each button is
configured with the MobilePlanner software.

» Goals will be serviced by the AIV in the order in which you touch their buttons.

 The selected dropoff goals are not sent to the queuing manager until you touch Go. After
being received by the queuing manager, each goal is considered to be a job.

o Touching a Planned (selected) dropoff button will de-select it, without affecting other
Planned dropoff buttons.

Simply touching a Pending or In-Progress goal button will not affect the associated job.
An explicit Cancel is required to cancel a job in either of those states.

» Buttons will change appearance when you select/de-select them, change their priority,
when the job is received by the queuing manager, when an AlV is on its way to the but-
ton's goal, and when the job is completed (and AIV dismissed).
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Cancel Request (X)

When a dropoff button has a blue or green border, meaning its job is Pending or In Progress,
the Operator can touch the button and a Cancel pop-up button (X) will be displayed on the but-
ton. Touching that pop-up will cancel the job for that goal. This does not affect any other jobs.
See Touchscreen Dropoff Goals Page, with Cancel and Hi-Priority Pop-ups on page 120.

High Priority ()

If you touch-and-hold the dropoff button for a goal that is planned or requested, or simply
touch the button for a job that is pending, a High-Priority pop-up button (!) is displayed. Touch-
ing this pop-up will toggle the priority for the goal or job between high and normal priority.

See the following graphic.

When a job is assigned high priority, its dropoff button will display a visible high-priority
indicator (!). A high-priority job will be serviced before all normal-priority jobs, even if those
jobs were entered at an earlier time.

This means that if you touch Goall, then Goal2+HighPriority, then Goal3, they will be serviced
in this order: Goal2, Goall, Goal3.

If you de-select a high-priority dropoff button, and then re-select it, it will appear as normal pri-
ority (the high-priority flag is not persistent).

NOTE: Changing a high-priority dropoff button or job to normal priority will
move that button or job to the end of the queue, so it will be serviced last.

Figure 7-11. Touchscreen Dropoff Goals Page, with Cancel and Hi-Priority Pop-ups
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Figure 7-12. Touchscreen Dropoff Goals Page, with Stay and Count-down Timer

Stay Button

If the AIV is en route to a goal when Stay is touched, that goal’s button will be turn dark blue
with an orange border.

If the AIV has entered a wait task associated with a goal or job, touching Stay merely extends
that wait, and the button border stays green. (The job isn’t interrupted from the queuing man-
ager’s perspective, the wait task has just been prolonged.)

Go Button

The bottom of the center pane, in Dropoffs and user-selected Home mode, is a Go button. This
zeroes the countdown timer, and causes the AIV to immediately proceed to its next goal. This

can be used in conjunction with the Stay button to pause the AIV, and give the Operator more
time to load or unload the payload.

Patrol Route Mode

The AIV does not communicate with the queuing manager in this mode.
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Figure 7-13. Touchscreen, Patrol Route Page, in Stay Mode

An Operator can touch Stay, to pause the AIV, and Go to release it, but the Operator cannot
select the AIV’s next goal. That is determined by the patrol route.

7.2 Operator Panel
E-Stop Button

When pressed, the red, latching push-button prevents any transporter motion by disabling the
motors. To reset the E-Stop, twist the button slightly, so it pops up.

The motors must be explicitly enabled, either with the dialog box that will pop up (MobilePlan-

ner software with Map > Show Robot on), with the ON button, or with an ARCL command.
See the following figure:

Figure 7-14. Motor Enable Pop-up Dialog
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In normal use, the E-Stop button is used for three primary purposes:

» You need to interrupt or stop the platform for some reason, to keep it from performing
its currently scheduled task (and don’t have access to MobilePlanner).

* You are working near the platform and don’t want it to move.

¢ You want to use the Brake Release button.

NOTE: There is a two-second delay between the manual release of an E-Stop
and the transporter resuming its activity. During the two seconds, the transporter
scans its path for potential obstacles. It will resume commanded motion
provided there is adequate space to maneuver.

ON Button

The ON button is used for restoring power after the OFF button has been pressed, and the soft-
ware has finished shutting down the platform.

It can also be used to restore power after an E-Stop has been pressed.

OFF Button

The red OFF button removes power from all systems except the charging hardware circuits.
The platform's software systems prevent loss of data on shutdown, and save the AIV’s last
known location so it automatically localizes when it is next powered on.

NOTE: The OFF button can be disabled by the keyswitch, which can be locked
and the key removed.

Brake-release (BRAKE) Button

The brake-release releases the brakes on the platform. It is used when you need to manually
move the AIV.

Battery power is required and an E-Stop must be pressed to release the brakes.

The BRAKE button must be held in to keep the brakes released.

Version Information: The LD-130CT is difficult to move manually, even using
the brake release.

Keyswitch
The keyswitch can be used to disable the OFF button. The key can be removed in either the
locked or unlocked positions.

LATCH Button

The Operator can manually make the platform latch to the cart by pressing this button. The
platform must be in the correct position for latching with the cart for this to work. The button’s
light will be lit blue when this is enabled.
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UNLATCH Button

The Operator can manually unlatch the platform from the cart by pressing this button. The but-
ton’s light will be lit blue when this is enabled.

7.3 Other Controls and Indicators

A beacon is mounted on the top of the HMI post. See Operator Panel, with Acuity Option
Shown on page 111.

Light Discs and Beacon

Circular lights on the sides of the platform are used to indicate motion, turns, and several
other states.

A beacon is used to indicate movement and to signal an Operator that the AIV is waiting for
assistance.

Their states are described here, and summarized in the following tables.

Driving Straight

Blue arcs on each side of the platform will appear to rotate in the direction of the platform's
travel, to let nearby people know that it is moving (or about to move). Beacon blinks green.

9[@®)

> > > >

Turn Signal (for turns >30 degrees)

The blue drive indicators will include a blinking orange segment at the front of one light disc
to indicate that the platform is about to turn in the direction of the signal.
Beacon blinks green.

OOOGIC

> > > > > >

Stopped, no errors (ready)

Entire light disc on each side pulses blue slowly (0.25 Hz). Beacon is steady green.
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(D00annn)

Slow pulse: —3» —>» —>> o —>>

Driving with Warning (doesn't prevent driving, such as low battery)

The Light Discs will be orange instead of blue for Stopped, Driving, and Turn Signals.
Beacon alternates green then yellow.

OO0Q

> > > >

Turn Signal with Warning (doesn’'t prevent driving, such as low battery)

Same as Turn Signals, but both the blue rotating arc and blinking segment are orange. The
moving arc and the blinking segment have independent timing.

000

> > > > > >

Driving Slowly, E-Stop Inactive

When driving under 300 mm/s, the LD does not generate E-Stop, however it still actively per-

forms safety checking and successfully avoids obstacles. The pattern is essentially the same as
driving, except the background blinks orange. The moving arc and the blinking segment have
independent timing.

000LOU

e A S e e e

Stopped with Warning (such as low battery)

The light discs will be orange instead of blue for Stopped with Warning. Beacon alternates
long green with short yellow.
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Obstacle Detected

(0gganan)

Slow pulse: —3» e —> > >

The Light Discs will blink yellow if the AIV is stopped for an object in its safety zone. Beacon

blinks yellow.

Lost

0000

> > > >

When the AIV is lost, the Light Discs will each display two orange arcs, traveling from the 6

o'clock to the 12 o'clock position and back, in opposite directions. Beacon blinks yellow.

Charging

PN

When docked, a green arc will indicate the current state of charge (SOC), showing steady green
from the top of the disc to the current SOC. A small white arc travels back and forth between

the two ends of the green arc. Beacon blinks green (red if E-Stopped).

126

SO

25% 50% 75% 100%
Left Side Right Side State of Charge
0to90 cw 0to 270 ccw 25%
0to180 cw 0 to 180 ccw 50%
0to270 cw 0 to 90 ccw 75%
full circle full circle 100%
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NOTE: The state of charge displayed is continuous, not limited to 25% incre-
ments.

E-Stop
The Light Discs will blink red in an E-Stop condition. Beacon blinks red.

OO,

> > > >

Booting

When booting, the Light Discs will display two blue arcs, traveling from the 6 o'clock to the 12
o'clock position and back, in opposite directions. Beacon alternates green, yellow, then red.

OO,

> > > >

In the following table:

 Blink indicates that a disc or light is on for a period, then off for a period.

o Pulse indicates a 0.25 Hz fade on and off.

« Circle indicates that the lights appear to be going in a circle.

» Half-circles indicates two arcs, moving opposite each other between the top and bottom.
 Solid indicates that a light is on continuously.

o Altindicates that the beacon switches between different lights, with no pause. Two
lights with Alt means one light is always on, but not two at once.

Table 7-1. Indicator Meanings

Light Disc Beacon Meaning
Color Pattern Color Pattern
Blue Moving Green Blink Driving straight,
Circle all ok
Blue/ Moving Green Blink Turning > 30 degrees
Orange Circle/ in
@front Blinking signal direction of orange turn
signal, all ok
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Light Disc Beacon Meaning
Color Pattern Color Pattern

Blue Pulse Green Solid Stopped, all ok
Orange Moving Green Alt Drive with warning,

Circle /Yellow doesn't prevent driving

e.g. low battery

Orange/Orange | Moving Green Alt Turn with warning
@front Circle/ /Yellow

Blinking signal
Blue/ Moving Green Blink Driving slowly, <300
Orange Circle/ mm/sec

Blinking signal
Orange Pulse Green/Green/Green | Alt Stopped with warning

/Yellow
Yellow Blink Yellow Blink Object detected in
safety zone

Orange Left+Right Yellow Blink Lost

Half-circles
Green/White Partial Circle/- Green normally, Red | Blink Charging
arc moving small arc | if E-Stopped
Red Blink Red Blink E-Stop, stops driving
Blue Left+Right Green/Yellow/Red Alt Booting

Half-circles

LD Platform Core Indicators

The left end of the LD Platform core has 12 indicator lights.

Figure 7-15. Core Indicator Lights

The following table gives their meanings:
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Indicator Meaning

Left Column

LOGIC The microcontroller has power

PC The LD Platform core and the servo controller are communicating

DRIVE The drive wheels are under servo control

ESTOP An E-Stop has been activated

Middle Column

20V 20 V power is available

12V 12 V power is available

5V 5V power is available

VBAT Raw battery power is available

Right Colum

=)

LAN MAINT | The Maintenance Ethernet connector is showing activity

LAN USER | The USER LAN connector is showing activity

WLAN The WiFiis showing activity

HD The hard drive is showing activity

Battery and Docking Station
For the battery, see Battery Indicators and Controls on page 134.
For the docking station, see Docking Station on page 135.
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Before proceeding, you need to have performed the steps covered in the Setup and Con-
figuration chapters, so your platform has a map to work from.

8.1 Operating Environment

Intended Use

The LD Platform Cart Transporter is designed for operating in indoor industrial or pro-
fessional environments. It must be deployed in a manner that takes into account potential
risks to personnel and equipment. The product is not intended for use in uncontrolled areas
without risk analysis, for example, areas open to general public access. Use in such areas may
require deployment of additional safety measures.

Clearance

The LD Platform Cart Transporter is designed to operate in an environment that is level and
has no doors or other restricted areas too narrow for the cart or transporter.

It is the user’s responsibility to ensure that adequate clearance is maintained on each side of
the AIV, so that a person cannot get trapped between the AIV and a wall or other fixed object.
You should consult the applicable standards for your area.

An exception to side clearance can exist at pickup and drop off locations, where the AIV must
get close to conveyors or other fixed objects.

CAUTION: PROPERTY DAMAGE RISK

Do not allow the AIV to drive through an opening that has an automatic gate
or door unless the door and AIV are configured correctly with the Door Box
option.

Refer to the LD Platform Peripherals Guide for details on the Call/Door Box.

Obstacles

If the AIV will be entering high-traffic areas, the user must take appropriate precautions to
alert people in those areas that an AIV might enter. If the traffic consists of other machines, the
user must adjust the AIV’s and/or the other machine’s parameters to reduce the risk of a col-
lision.

Care must be taken to avoid:
« glass doors and walls
« pits without railings or low bumpers

« floors with access panels removed

« loose cables, hoses, etc.
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This specifically includes wires hanging from above the AIV, which could pose a
hazard if the AIV ran into them.

« large, highly-reflective objects

Environment and Floor

Floors must be level and provide good traction, typical of good walking conditions.

o Temperature 5 to 40°C (41 to 104°F)
o Humidity 5% to 95%, non-condensing
o Altitude Up to 1000 m above mean sea level

NOTE: Read the warning that follows step and gap traversal.
Any steps must have a smooth, rounded profile.

« Step traversal Up to 5 mm (0.2 inch) at 250 mm/s only
« Gap traversal Up to 5 mm (0.2 inch) at 250 mm/s only

CAUTION: PROPERTY DAMAGE RISK

The transporter with cart is designed and intended for smooth, level floors.
While it is capable of driving over a step or gap as listed, frequent or high-
speed driving over steps or gaps will shorten the lifespan of the drivetrain com-
ponents.

NOTE: At less than the recommended speed, the LD Platform Cart Transporter
may not be able to traverse the step height listed.

The LD Platform Cart Transporter is not intended for use in hazardous environments (explos-
ive gas, water, dust, oil mist). It has an IP rating of IP20.
The LD Platform Cart Transporter is not intended for use in the presence of ionizing or non-
ionizing radiation.

Platform Getting Stuck

It is possible, though not likely, for the platform to get into a position from which it cannot
move without Operator assistance.

Some examples are shown in the following figure.

If the platform has to be lifted to be free to drive again, refer to Safety Measures Prior and After
Maintenance on page 148.
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Figure 8-1. Examples of the Platform or AIV Getting Stuck, (A) Platform Stuck Under Overhang,
(B) ALV Option Stuck Under Overhang, (C) Driven off Ledge, and (D) Driven Over Excessive Gap

Cart Getting Stuck on Platform
To remove a cart that is stuck in the latched position:

1. Power off the cart transporter completely.

2. Press and hold the Unlatch button on the Operator panel until the transporter is fully
unlatched. It should take about 5 seconds for the latch to start moving.

8.2 Typical Operation

During normal startup, your platform powers all its onboard systems! and runs its onboard
software automatically to provide an application-ready AIV. If it has been given a map of its
workspace and knows where it is within that environment (localized), your AIV is ready to
perform on startup and will operate autonomously, without human intervention.

Paths are not pre-programmed, but instead are generated dynamically onboard the platform.
Paths are updated many times per second to maintain a smooth trajectory and to account for
any obstacles that are detected by the onboard sensors. Navigational parameters are stored
onboard the platform, and can be viewed and modified using the MobilePlanner software,
which is covered in the Mobile Robot Software Suite User’s Guide.

1As configured either by the factory or through your own parameter changes.
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The MobilePlanner application, running on your computer, is used to configure the many
high-level operating characteristics of the platform, including speeds and accelerations, sensor
safety zones, minimum battery level allowed before docking for recharging, which map to use,
and many other parameters. The MobilePlanner software typically communicates with the plat-
form over the wireless network. A direct connection, through the Maintenance Ethernet port on
the platform, is also possible.

IMPORTANT: The Operator Mode of the MobilePlanner software, which does
not require a license to run, should be protected with user ID and password
access, to prevent unauthorized operation of an AIV.

8.3 Power and Charging
The platform battery supplies ample power for the motors, electronics, and accessories.

The platform ships separately from the battery. The battery is shipped at less than 30% charge,
to comply with air-shipping regulations. You should have installed the battery in the platform
in Installing the Battery on page 45. You should fully-charge it as soon as possible, to avoid
battery damage from a full discharge.

Battery recharging is typically managed by the platform. With ample power, as is provided by
the automated docking station, all onboard systems function continuously while the battery
recharges.

The Operator screen shows % state-of-charge (SOC) remaining for battery.

Run-time, with no load, is approximately 15 hours. This will vary significantly depending on
operating conditions.

Recharge time is approximately 4 hours.

Battery Indicators and Controls

The battery has (from left to right) one red/green bi-color and three green LEDs, and one push-
button (labeled SHOW LEVEL). The firmware blinks LEDs 1 through 4, back and forth, one at
a time. From left to right, the LEDs indicate:

LED Color Meaning
1 Red Error condition@
Green 25% state of chargeP
2 Green 50% state of charge
3 Green 75% state of charge
4 Green 100% state of charge®

a: If the red light blinks after pressing the SHOW LEVEL button, the battery is depleted and
needs a recharge.

If the red light blinks constantly, the battery needs service. Connecting the battery to a
platform will write an error code to the log, which will allow Service to better
troubleshoot the problem.

b: While powered up, the LEDs blink back and forth from 1-4.
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LED Color Meaning

c: When on the docking station, the right-most LED blinks when the battery the pack is
balancing. When the battery is full and balancing is complete, all LEDs light solid.

Figure 8-2. (A) Battery LEDs and Push-Button (Show Level), (B) Power Cable, and (C) Data Cable

Pushing the “SHOW LEVEL” button displays its state of charge. This can be useful when a bat-
tery is in storage, and you want to know its state of charge.

NOTE: After pressing the SHOW LEVEL push button, the battery will light all
LED:s for a brief time, then blinks the LEDs back and forth one LED at a time, up
to the LED representing the current state of charge. It will continue doing this for
4 hours, until it powers itself off. To turn off this display manually, press and
hold the push button for 10 seconds.

Docking Station

The automated docking station is both a manual and an automated means for recharging your
platform battery.

Autonomous Charging

During normal, autonomous operation, the AIV manages charging automatically through the
automated docking station. The AIV approaches the docking station frontward, and then turns
around and backs onto the docking station to charge. There is about a 10-second delay
between when an AIV docks and the charging LED turns on.

Connecting and disconnecting the AIV with network and onboard clients will not disturb the
charging state (though moving the AIV will, of course). The station supplies ample power for
all onboard systems while charging its battery, so you can continue operating those systems
while charging.

If the ALV is powered off, it will turn on automatically when pushed onto the docking station.
The robots can be turned off while on the docking station. If the robot is turned off, it must be
removed from the docking station to be started.
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Figure 8-3. Docking Station

Indicators, Controls, and Connections
The docking station has a power switch and two LEDs:

« blue indicates that power is available.
« yellow indicates that a charge is in progress.

The power switch, located on the right side of the dock, has an integrated thermal fuse, which
can shut down the dock if it becomes too hot. If this happens, you have to wait for the fuse to
cool down, toggle the switch to off (0) and then back to on (1).

The power plug for AC supply is next to the power switch. Power requirements are 100-240
VAC, 50-60 Hz, and 8 A.
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The plug for connecting the manual charging cable is on the left side of the station, as viewed
from the front.
Environmental Requirements

« Ambient temperature range: 5 to 40°C (41 to 104°F)

o Humidity: 5% to 95% non-condensing

Maintenance

The docking station contacts should be cleaned quarterly with isopropyl alcohol. See Docking
Station Contacts on page 156.

The guide roller can be replaced in the field. See Docking Station Roller and Bearing on page
166.

If necessary, the height of the docking station contacts can be adjusted. See Docking Station
Contact Adjustment on page 54.

Manually Charging the Battery

Battery in Platform

To manually charge a battery inside the platform, push the platform backwards, with E-STOP
engaged, so that the rear of the platform slides over the contacts of the docking station.

There is about a 10-s delay between when the platform is in position and when the charging
LED turns on.

NOTE: You will need to press and hold the brake release button before moving
the platform.

NOTE: If you push the platform too far onto the docking station, it will not
charge. Make sure that the yellow charge light comes on and stays on.

Standalone Battery

The battery can be charged, outside of the platform, by using the connector on the left side of
the docking station (viewed from the front) with the provided charging cable. This will most
likely be used for charging a spare battery, while a second battery is still in the platform, and
the platform is in use. Some users choose to manually charge a spare battery, and swap that
for the battery inside the platform.

There is about a 10-s delay between when you connect the battery cable and when the char-
ging LED turns on.

NOTE: The docking station cannot charge a platform and a separate battery at
the same time. If a platform is on the station, the power to the manual charge
connector is cut off.

Balancing the Battery

The platform battery is composed of multiple cells, which need to stay balanced in order to
maintain maximum run-time.
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There are three ways for managing battery balancing:

o Set the platform’s DockUntilDoneCharging parameter to True. In this case, the battery
will balance before saying it's done charging, so the battery will get balanced every time
the platform docks. You do not have to do anything extra to balance the battery.

In this mode, the battery will typically take about 10 minutes to balance after charging.

NOTE: This is the mode that is recommended for platforms that aren't
doing battery swapping.

» Exchange the in-service battery, periodically, with a fully-charged spare battery.

A spare battery that remains plugged into a docking station will be balanced. In this
mode, you don’t have to worry about battery balancing, although it does add the task of
manually swapping batteries.

The interval between battery swaps depends on how the AIV is used. This includes the
weight it carries, and what percent of the time it is in service. You will need to determ-
ine the best interval for your situation. Swapping the battery at every shift change is a
commonly-used interval.

NOTE: This is the mode that is recommended for battery swapping, if
you are not charging the battery while it is inside the platform.

o Set the platform’s DockUntilDoneCharging parameter to False, to let the platform get a
partial charge by docking. The StateOfChargeToChargeTo and MinutesToChargeFor
parameters need to be set to appropriate (non-zero) values. You would then do a battery
swap with a fully-charged and balanced battery periodically, such as once a week.

o StateOfChargeToChargeTo determines the state of charge the battery needs to
attain before the platform can stop charging.

A 90% value here would get the battery mostly charged, but not balanced.

o MinutesToChargeFor determines the number of minutes the battery needs to
charge before the platform can stop charging.

The platform will stop charging when the battery reaches either of these para-
meter values.

NOTE: If both of these parameters are left at the default of 0, and Dock-
UntilDoneCharging is set to False, the platform will dock, and never
undock.

We recommend that you do a battery swap weekly, at a minimum. If you see a reduc-
tion in run-time, you should do a swap more often than that.

NOTE: The longer you wait to balance a battery, the longer it will take to

balance. A battery that is badly out of balance can take well over 10 hours
to balance after charging.
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8.4 Startup

Procedure

Press and hold the ON button for 0.5 s, then release. It takes about a minute for all the systems

to start up and make their various interconnections. If the platform doesn't start up, try power
OFF, check your connections, and then power ON.

Startup is complete when the Light Discs stop indicating boot (two blue light segments, mov-
ing in opposite directions from 6 o'clock to 12 o'clock and back).

Joystick

The joystick lets you quickly move the platform to its destination. This can be used to drive it
from the shipping dock to an automated docking station.

IMPORTANT: The joystick should be locked up when not in use, to prevent
unauthorized operation of an AIV.

Figure 8-4. Joystick, (A) Speed Control, (B) Goal Button, (C) Directional Control, and (D) Trigger

The joystick plugs into the left side of the platform, under the small access panel at the upper
right corner of the platform. (The Maintenance Ethernet port is also there.) The access panel is
held in place with a push-push latch, and retained by a lanyard.

CAUTION: PERSONAL INJURY OR PROPERTY DAMAGE RISK

The platform safety scanning laser is not tied into the E-Stop chain when
driven using the joystick. The Operator should maintain control of the joystick
and the AIV whenever the joystick is connected to the AIV.

Joystick Use

Use the joystick to drive the platform manually. Squeeze the trigger to enable the drive button.
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8.5 Working with Carts

Push the drive button forward or back to make the platform move in that direction. Push the
drive button to the side to make the platform rotate in that direction. Diagonal positions of the
drive button move the platform in an arc.

The platform slows to a stop when you release the trigger. To stop more quickly, continue to

squeeze the trigger and pull or push the drive button to its limit in the opposite direction of the
platform’s travel.

8.5 Working with Carts

Goals

The parking goals and the LD Platform Cart Transporters need to be set up in the MobilePlan-
ner software. Refer to Configuration on page 61 for details on MobilePlanner configuration,
and see the Mobile Robot Software Suite User’s Guide.

Operation

The transporter locates the cart, couples with it, transports it to the dropoff goal, and
uncouples from the cart, leaving the cart at the dropoff goal while it proceeds to its next
assigned job.

Cart-Locating

If a cart is at a parking goal, the transporter can navigate close enough to the cart for the Latch-
ing Mechanism to take over.

The Latching Mechanism pulls the transporter and cart together, which enables a sensor to

detect that they are fully-coupled. Once the coupling sensor is triggered, the transporter will be
able to move the cart.

CAUTION: PINCH RISK
The latch on the transporter can pinch you if you are not careful. Keep your
hands clear of the Latching Mechanism when it is in action.

CAUTION: PINCH RISK
The coupling action of transporter and cart can pinch you if you are not care-

ful. Keep your hands clear of the space between the HMI post and cart when
the platform and cart are coupling.

NOTE: If the sensor does not get triggered, the transporter’s software will pre-
vent it from moving.

Cart Brakes

The two rear casters of the cart have brakes, which push a blunt pin against the caster rolling
surface to prevent a cart from rolling when it is parked on a floor that is not perfectly level.

Cart brakes are only intended to prevent rolling on a slightly unlevel floor. They will not imme-
diately stop a moving cart, or prevent a cart from rolling down a slope.

Although it is possible to push the cart with the brakes engaged, this is not recommended
because it will accelerate wear of both the braking pins and the casters themselves. When a
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cart needs to be moved, the Operator should always release the brakes with the brake release
handle.

In the unlikely event that the cart becomes unlatched from the platform while in motion, the
brakes are designed to stop the cart within six feet.

Automatic Brake Release

When the transporter couples with the cart, it actuates a lever that releases the cart brakes, so
the cart can move freely with the transporter.

Manual Brake Release

When there is no transporter present, the cart brakes can be released manually. Each cart
comes with a release cable and lever, similar to a bicycle brake handle, that releases the cart
brakes when squeezed. Installation of this cable and lever is covered in Installing the Cart
Brake Release on page 54. As long as the brake release handle is squeezed, the brakes will be
released.
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Chapter 9: Options

The LD Platform Cart Transporter is available with a number of options to enhance its per-
formance and abilities.

Enterprise Manager

The Enterprise Manager manages a fleet of AlVs, for multi-AIV coordination and job man-
agement. It includes the Enterprise Manager appliance running the Mobile Software suite.

It is covered in the Enterprise Manager user's guide.

MobilePlanner Software (licensed)

In order to have your LD Platform Cart Transporter perform autonomous mobile activities, you
need to make a map of its operating space, and configure its operating parameters. The
MobilePlanner software is used to make this map and perform this configuration.

Refer to the separate Mobile Robot Software Suite User’s Guide for details on how to map a work-
ing space and prepare the virtual elements, goals, routes, and tasks for your application.

The MobilePlanner software requires a license to run. You need at least one MobilePlanner
license for each fleet of AIVs. Once a map is generated, it can be shared with multiple AIVs
working in the same space.
Joystick
This is mainly used to drive the platform when doing a scan, in preparation for making a
map of the workspace. You need at least one joystick for each fleet of AIVs. Once a map is gen-
erated, it can be shared with multiple AIVs working in the same space.
Spare Battery
At least one spare battery is needed if you opt to swap the platform’s battery, rather than hav-
ing it charge itself at a docking station. See Manually Charging the Battery on page 137.
Spare Carts

Extra carts can be ordered, because a cart installation can use more carts than transporters.

The part number is 75020-000.

The following options are documented in the LD Platform Peripherals
Guide.

Call Buttons/Door Boxes

Call buttons are used to issue a request for an AIV to go to the goal associated with the button.
There may be multiple call buttons, even in an installation where there is only one transporter.

Door Boxes are used to open an automated door, so the AIV can pass through.
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See LD Platform Peripherals Guide.

Acuity Localization

Acuity localization uses an upward-facing camera to localize the platform using overhead
lights, which it compares with lights stored in its map. This can be used in circumstances
where laser localization is difficult, either because the environment has too many changing fea-
tures or simply not enough features for laser localization. If there are many objects, such as pal-
lets or carts, which change location frequently, they may not be on the platform’s map, and
may also block the laser’s view of features that are on the map. In such cases, Acuity loc-
alization may be a better choice than using the safety scanning laser for localization.

®

©

©
® @

Figure 9-1. Acuity Parts

Callout Description Callout Description
A Foam Dust Seal F Bracket
B NOTE: Top ND filter not shown. G Direction of Travel label
C Tube H M4 x 12 screws go up through
base
D Camera ] Base
Camera mounting screws

High-Accuracy Positioning System

This allows an AIV to achieve accurate alignment at a specific location, typically at a fixed con-
veyor, using a sensor to detect magnetic tape at that location.
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Chapter 10: Maintenance

This chapter covers periodic maintenance and user-serviceable parts replacement for the LD
Platform Cart Transporter.

Figure 10-1. Major LD Platform Cart Transporter System Parts, with Acuity Camera

Callout Description Callout Description
A Operator Panel G Rear-facing Laser, Guard
B Side Lasers, Guard x2 H Light Disc x2
C Laser Support Tube x2 J Rear Sonar
D Brace x2 K Battery Cover
E Navigation Laser L HMI post
F Low Front Laser
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Figure 10-2. Top View of an LD Platform Cart Transporter, Side Laser Support Tubes Removed

Callout Description Callout Description
A HMI Pose Base H E-Stop, Latch, Unlatch
B Top Plate ] Light Pole (Beacon)
C Coupling Laser Cover K Touchscreen
D Latch Position Sensor L On/off/Brake/Key Switch
E Latching Mechanism Cover M Operator Panel
F HMI Post N Rear-facing Laser
G Antenna x2 ] Car Latch

146

Figure 10-3. Location of Parts in the Payload Bay
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Callout Description Callout Description
A Platform Core C Core Mounting Bracket
B Platform Sonar Controller D Payload Bay

10.1 Safety Aspects While Performing Maintenance

IMPORTANT: Only skilled or instructed persons, as defined in the Mobile
Robot LD Safety Guide, should perform the procedures and replacement of parts
covered in this section.

Electrical Hazards

WARNING: ELECTROCUTION RISK

During maintenance and repair, the power to the docking station must be
turned off. Remove and lock up the power cord to prevent unauthorized third
parties from turning on power. The access covers on the docking station are
not interlocked.

WARNING: ELECTROCUTION RISK

There are no user-serviceable parts inside the docking station. Do not remove
the covers of the docking station. There is high voltage inside, and the covers
are not interlocked.

CAUTION: SHOCK RISK

During maintenance and repair of the transporter, turn off the transporter and
disconnect the battery as soon as possible. Avoid shorting the terminals of the
battery.

> P B

Burn Hazard

CAUTION: BURN RISK
Parts of the drivetrain can get hot during operation. Allow the platform to cool
down before servicing.

>

Pinch Hazard

Platform Covers

CAUTION: PINCH RISK

The covers are held in place with strong magnets, which can pinch you if you
are not careful. Follow the instructions in the Maintenance chapter for hand-
ling covers.

>
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10.2 Safety Measures Prior and After Maintenance

Magnetic Field Hazards

Platform Covers

WARNING: MAGNETIC FIELD - MEDICAL IMPLANT RISK

Magnetic fields can be hazardous to medical implant wearers. Medical
implant wearers stay back 30 cm (12 inches) from the covers, which are held in
place with strong magnets.

Docking Funnel

WARNING: MAGNETIC FIELD - MEDICAL IMPLANT RISK

Magnetic fields can be hazardous to medical implant wearers. Medical
implant wearers stay back 30 cm (12 inches) from the underside of the plat-
form, which is exposed during certain maintenance procedures for which the
platform is tipped on its side.

10.2 Safety Measures Prior and After Maintenance

Prior to performing maintenance work (safety inspection, cleaning, removing parts, installing
parts, etc.), following safety measures must be taken:

» Ensure that the AIV has come to a complete stop, by pressing the E-Stop button on the
Operator Panel
o Power OFF the ALV by pressing the OFF button on the Operator Panel

Once maintenance work has completed, and the AIV is ready for use, take following actions:

o Power ON the AIV by pressing the ON button on the Operator Panel
« Release the E-Stop

10.3 Lifting the Platform Safely

If, for any reason, you need to lift the platform by hand, take care to lift from safe lifting points.

WARNING: PROPERTY DAMAGE RISK
Lifting the platform from the wrong points can damage the platform.

Front Lifting Points

On each side of the laser, under the upper side of the laser slot. Do not lift at the center - there
is no frame supporting it there. Do not lift anywhere else! Refer to the following illustration:
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Figure 10-4. The Upper Surface of the Laser Slot. (A) Lift Here Only, and (B) No Lift

Rear Lifting Area

The center underside of the platform, where the cover has a raised section. Do not lift any-
where else! Refer to the following illustration:

Figure 10-5. Bottom of Battery Door Skin. (A) Lift Here
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10.4 Safety Inspection

10.4 Safety Inspection

Item Period Reference
Warning Devices 1 week Warning Devices on page 150
Warning Labels 1 week Warning Labels on page 150
Informative Labels 1 week Informative Labels on page 153

Warning Devices

The following warning devices should be inspected for proper function on a weekly basis.

Light Discs

The light discs on each side of the transporter should be checked.

Flashing Light(s)
The beacon on top of the HMI post should be checked.

If there is a user-installed beacon or light tower that has been installed to warn people of the
AIV’s movement or imminent movement, it should be checked for proper function every week.

You should ensure that the light remains visible under all operating conditions, so that, regard-
less of your payload structure design, any people near the AIV can see it.
Buzzer

The warning buzzer should be checked for proper function. In order to maintain conformity
with applicable standards, it is important that the buzzer be audible in all operating con-
ditions and environments.

Warning Labels

See Figure 10-6. and Figure 10-7.

All warning labels on the LD Platform Cart Transporter should be checked on a weekly basis
for being present and legible. If any of the labels are missing or illegible, they should be
replaced. The labels, with part numbers, are:

 Invisible Laser Aperture Label, 13307-000L

One of these labels will be on the front navigation laser.
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o Laser Aperture Label, 13308-000L

One of these labels will be on each of these lasers:

o Low Front laser

o Left and Right Side lasers
o Rear laser

o Coupling laser

« Pinch Point Label, 12992-000

A pinch point label is on top of the latch mechanism cover.

« Hand-entanglement Label, 18180-000

A hand entanglement label is under the latch mechanism cover, near the belt and pul-
ley. See Removing Latching Mechanism Cover on page 156 for instructions on remov-
ing the cover.
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o Medical Implant, Magnetic Field Warning Label, 18621-000

One magnetic field/implant label is on the transporter rear cover.
A second is on the top rear bar of the cart.

A third is on the underside of the transporter, on the docking funnel. This magnet is
only exposed during maintenance, when the transporter is tipped on its side.

e Yellow circle surrounding the E-Stop, 11229-167

This is labeled EMERGENCY STOP. It is located on the Operator Panel, at the top of the
HMI post.

» No Riding Label, 18178-000

One of these labels is located on the LD Platform Cart Transporter top plate, near the
front.

Another is on the top rear bar of the cart.
e No Incline Label, 18179-000

A no incline label is attached on the top plate of the transporter, in front and to the side
of the plastic triangle for aligning with a cart.
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¢ Automatic Vehicle Label, 18623-000

4 N\

A CAUTION

AUTOMATIC
VEHICLE

. J

An Automatic Vehicle label is attached to the rear cover of the LD Platform Cart Trans-
porter.

Informative Labels

The following labels are on the Operator Panel, at the top of the HMI post. They should be
checked on a weekly basis for being present and legible. If any of the labels are missing or
illegible, they should be replaced. The labels, with part numbers, are:

o HMI post button label, 14463-000
This includes the BRAKE, ON, OFF, and Keyswitch labels.
o HMI post LATCH, UNLATCH button labels, 14628-000

Figure 10-6. Locations of Labels on LD Platform Cart Transporter

Callout Description Callout Description

A Pinch Hazard Label F E-Stop Button
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Labels

B Hand-Entanglement Label (under cover) G On, Off, Brake Labels
C No Ride and No Incline Labels Magnetic Field Labels
D Laser Labels (Underside of Platform)
E Latch, Unlatch Labels
Figure 10-7. Magnetic Field/Implant, and No Riding Labels on Cart
Callout Description Callout Description
A Magnetic Field and No-ride B 6 mm diameter (0.25 in.) Pass-

through hole for brake cable,
through rear frame tube

10.5 Cleaning

Work Area Maintenance

The work area of the AIVs must be kept generally clean and free from clutter that could block

an AIV.

Anything spilled on the floor of the work area, such as dust, ice, pooled water, etc., must be
removed immediately, as this would interfere with the AIV’s ability to drive safely, as well as
navigate. Any substance that reduces the AIV’s traction with the floor will impair its ability to
drive, stop, turn, and navigate. Pay particular attention to areas around goals and frequently-
traveled paths.

LD Platform Cart Transporter and Cart

Some parts of the LD Platform Cart Transporter require periodic cleaning. The following table
gives a summary of cleaning procedures for the LD Platform Cart Transporter system.
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Table 10-1. Cleaning

Item Period Reference
Clean docking station 3 months Docking Station Contacts on page 156
contacts
Clean axles and tires As needed Tires on page 155
Clean casters As needed Casters on page 155
Clean all laser lenses - 6 months/as [ Laserson page 155
wipe clean needed
NOTE: The safety scanning laser will display a flashing icon of a windshield and wiper
when it detects that its lens needs cleaning.

NOTE: When the tires or floor get dirty, the wheels will tend to slip, and the
AIV can fail to localize. This is common near goals. Both the floor and the tires
need to be kept clean.

NOTE: The frequency of these procedures will depend on your particular sys-
tem, its operating environment, and the amount of usage. Operating in an envir-
onment with a lot of dust or dirt will require more frequent cleaning. Use the
intervals in this section as guidelines, and modify the schedule as needed.

Tires
Occasionally clean the tires with a mild soapy solution. Remove any dirt or debris that may
accumulate on the tires, because these can degrade the AIV’s performance.

Casters

Occasionally clean the casters with a mild soapy solution. Remove any dirt or debris that may
accumulate on them, because these can degrade the AIV’s performance.

This applies to the casters on the LD Platform Cart Transporter as well as on the cart.

Axles
Keep the axles free of hair, string, or anything that may wrap around and bind up the plat-

form’s drive.

Lasers

Occasionally clean the lenses of all lasers. Use only alcohol-based, non-abrasive cleaners, and
wipe thoroughly.
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10.6 Accessing the Payload Bay

Docking Station Contacts
The two docking station contacts occasionally need to be cleaned. The suggested interval is 3-6

months, depending on frequency of charging.

WARNING: ELECTROCUTION RISK
Unplug power from the docking station before cleaning. Remove the power
cord at the docking station.

Clean the contacts with isopropyl alcohol.

CAUTION: PROPERTY DAMAGE RISK
Do not lubricate the docking station paddle. Lubrication will reduce the life of
the paddle.

10.6 Accessing the Payload Bay

The payload bay is the area between the platform top plate and the top of the platform itself.
Care must be taken, when accessing the payload bay, that the wires and connections between
the platform and the HMI post and coupling plate are not damaged. See Top View of an LD
Platform Cart Transporter, Side Laser Support Tubes Removed on page 146.

The top plate is held on with eight M6 socket-head screws and two M5 cap screws. You
should not remove the HMI post base. The sheet metal cover of the Latching Mechanism
needs to be removed to access the two M5 screws. The top plate and the rest of the coupling
plate will come off together.

CAUTION: PROPERTY DAMAGE RISK
When lifting the top plate off, take extra care not to scratch the coupling laser’s
lens with the top plate itself.

Removing Latching Mechanism Cover
1. Remove the four M3 screws holding the Latching Mechanism cover to the top plate.
These go into four 45 mm standoffs in the top plate.
Retain the M3 screws for reassembly.
2. Lift off the Latching Mechanism cover.

Retain the cover for reassembly.

Removing Top Plate

1. Remove the two stainless M5 screws that were covered by the Latching Mechanism
cover.

Retain the M5 screws for reassembly. These are socket-head cap screws.

2. Remove the eight M6 screws along the sides and front of the top plate.
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Retain the M6 screws for reassembly. These are flat head, stainless screws.

3. Disconnect the cables going to the latching assembly and sensors in the Latching Mech-
anism.

4. Carefully lift off the top plate.

As you remove the top plate:

CAUTION: PROPERTY DAMAGE RISK
Take care not to scratch the laser lens when removing the top plate.

At this point, you will have access to the payload bay.
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10.7 Removing and Installing LD Platform Cart Transporter Covers

Installing Top Plate
1. Resintall the top plate.

CAUTION: PROPERTY DAMAGE RISK
Take care not to scratch the laser lens when reinstalling the top plate.

2. Reconnect the cabling to the latching motor assembly and its sensors.

3. Reinstall the eight M6 screws along the sides and front of the top plate.
Use the screws previously removed from the top plate.
4. Reinstall the two M5 screws that were covered by the Latching Mechanism cover.

Use the screws previously removed from the top plate.

Installing Latching Mechanism Cover

1. Place the Latching Mechanism cover back onto the top plate.

2. Reinstall the four M3 screws holding the Latching Mechanism cover to the top plate.
Use the screws previously removed from the Latching Mechanism cover.

These go into four 45 mm standoffs in the top plate.

10.7 Removing and Installing LD Platform Cart Transporter Covers

Many of the maintenance procedures require removing some of the platform's covers. Most
covers are held in place with just magnets. The rear outer cover has an additional brace at the
bottom for support, the bumper cover uses screws and magnets, and the access panel uses just
a push-push (toggle) latch.

Figure 10-8. LD Platform OEM Skins
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Callout Description
A Access Panel - covers the maintenance Ethernet port and joystick con-
nector.
B Left side skin - covers the LD left drive train.

C Right side skin - covers the LD right drive train.

NOTE: Both side skins hold a light disc and cover.

D Battery door skin - covers the battery access door.

Rear skin - covers the LD rear components, and houses the sonar trans-
ducer pairs.

F Front upper skin - Above the safety scanning laser and speakers.

G Bumper - Above the lower bumper assembly and low front laser.

With the exception of the bumper, no tools are needed for either the removal or installation of
the platform’s skins.

CAUTION: PINCH RISK
The magnets holding the covers in place are strong enough to pinch you if you
are not careful.

Additional Information: In general, it is better to install the payload structure
before installing the skins.

The covers are:

o Rear Inner (Battery)
o Access Panel

o Left Side, Right Side
Both side covers include a light disc and cover.

» Front Upper
o Bumper
o Rear Outer

With the exception of the bumper cover, no tools are needed for either the removal or install-
ation of the covers.

Removing Covers

NOTE: After removing covers, place them inner-side down, so the outer sur-
faces don't get scratched.
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10.7 Removing and Installing LD Platform Cart Transporter Covers

The covers can be removed in the order in which they are listed above.

o The rear outer must wait for the rear inner and the two side covers.
o The front upper must wait for the two side covers.

o The two sides, the rear inner, and the bumper cover can all be removed without remov-
ing any other covers, except that the left cover must wait for the access panel.

NOTE: The light disc covers are not covered here because they are only
removed from the side covers to replace one of the light disc controllers.

Rear Inner Cover (Battery)
This provides access to the battery compartment door.
1. Pull the bottom of the cover away from the platform chassis.
This is easiest if you grip it with two hands, toward the center.

2. Lower the cover down, so its top tab slides down, and clears the rear outer cover.

Access Panel
This provides access to the Maintenance Ethernet and the Joystick ports.
1. Push the left (front) side of the panel in, and the latch will release it.
Pushing the panel a second time will engage the latch.
2. When released, pull the left side out, and slide the panel to the left.
The panel is attached with a lanyard, to prevent getting lost.

You will need to place this panel out of the way when removing the left side cover.

Side Covers

1. For the left side cover, put the access panel out of the way.
2. Pull the bottom of the cover, at both sides, away from the chassis.
3. Work your way up the edges of the cover, pulling it away from the chassis as you go.

4. Remove the cover a few inches from the chassis.
The light disc wires plug into connectors on the inner side of each side cover.

5. Unplug the light disc connector, and move the side cover away from the platform.

Repeat for the other side cover.

Front Upper Cover
This cover is held onto the chassis the most tightly of any of the covers.

1. Grip the cover at the two outer edges.

2. Pry the cover away from the chassis.
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Bumper Cover
This is the only cover that requires tools to remove.
1. Remove the screws at the sides of the cover.
Retain the screws for reinstalling the bumper cover.
2. Pull the cover off of the bumper.

It is held on with magnets, as well as screws.

Rear Outer Cover

This cover houses the two rear sonar pairs, which must be disconnected once the cover is part-
way off the chassis. Each pair consists of one emitter and one receiver.

1. Pull the top of the cover away from the chassis a few inches.
The cover will pivot on the metal brace at its bottom edge.

2. Pull the four sonar wires, with their connectors, out of the chassis holes.

Refer to the following two figures.

Figure 10-9. Sonar Leads, with Connectors Still in Chassis
3. Unscrew all four sonar connectors.

Ensure that both sides of all connectors are labeled, and match. If not, label them.
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Figure 10-10. Sonar Connectors, with Connectors Exposed

4. Tilt the cover down to about 45°, and slide the brace on the bottom of the cover out of
its clip.

This will separate two pairs of magnets, so you will feel some resistance at first.

Installing Covers
The covers can be installed in the reverse of the order in which they are listed above.

o The front upper and rear outer covers must be installed first and second.

o The access panel must wait for the left side cover.

Bumper Cover
This is the only cover that requires tools to install.
1. Place the cover on the bumper.
It is held on with magnets, as well as screws.

2. Install the screws, removed during the cover removal, at the sides of the cover.

Front Upper Cover

1. Grip the cover at the two outer edges.

2. Align the bottom edge of the cover so it slides under the chassis support.
gn g pp

3. Tilt the top of the cover into position.

162 LD Platform Cart Transporter User's Guide 14766-000 Rev G



Chapter 10: Maintenance

Rear Outer Cover

Because this cover houses the rear sonar units, they must be reconnected once the metal brace
across the bottom is in the clip just below the battery access door.

1.

Slide the metal brace into the clip in the chassis.

Watch the two magnets on the bottom of the cover, to align them with their mating mag-
nets on the chassis. This is your best guide for getting this cover in its proper place.

These are inboard of the clip holding the brace, so you will have to look on each side of
the cover to check their alignment.

When the magnets at the bottom are lined up, tilt the cover up to within a few inches of
the chassis.

Pull the sonar connectors clear of the chassis, if they are not already out.
See the preceding figure.

Screw the four sonar connectors to their corresponding sonar leads.
Ensure that the labels for the connectors and leads match.

Tuck the connectors into the four holes in the chassis, until just an inch of sonar lead is
sticking out.

Tilt the top of the cover up to meet the chassis.

Side Covers

1.

Move the cover to within a few inches of the chassis, and plug in the light disc con-
nector.

The light disc connector is accessible on the inner side of the side cover.
Place the top edge of the cover on the chassis, so the magnets hold it there.
Make sure the gaps on each side of the cover are the same width.

Tilt the bottom edge of the cover down.

Check each side of the cover to ensure that the cover edges on each side of the gap stick
out the same amount from the chassis.

This is most likely to be uneven near the top of the cover.

If either edge sticks out more than the neighboring cover, pull the neighboring cover
away from the side cover slightly, and release.

This should allow the side cover to snap into place, so both sides of the gap stick out
the same amount.

Repeat for the other side cover.
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Figure 10-11. Right Side Cover, Showing Even Gaps at Edges

NOTE: The gaps between the side covers and the bumper cover will be smaller
than the other gaps, and will not be even.

Access Panel
1. Slide the panel to the right, so its tab goes under the left side cover.
The panel is attached with a lanyard, to prevent getting lost.
2. Press the left (front) side of the panel in, and the latch will hold it.

This is a toggle latch - pressing it once engages it, pressing it a second time releases it.

Rear Inner (Battery) Cover
1. Slide the cover up, so its top tab fits under the rear outer cover.
CAUTION: PINCH RISK
This cover is the most likely to pinch you if you are not careful, par-

ticularly at its bottom edge. Hold the cover at the bottom, in the center,
with two hands.

2. Holding the cover near the center, with both hands, tilt the bottom of the cover down,
towards the platform chassis.

10.8 Replacing Periodic Parts

The drive motors and gearbox are sealed and permanently lubricated, so they do not require
periodic maintenance.
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Maintaining and Replacing Batteries

Maintaining Batteries
» Every six months, inspect batteries (both stored and in-use) for damage or leaks.

If a battery is found to be leaking, do not expose it to water. If possible, submerge it in
mineral oil.

Contact your local Omron support immediately for disposal instructions.

« Store batteries fully charged and upright at (one month) +5 to 45°C (41 to 113°F); (one
year) 20 to 25°C (68 to 77°F).

« Every six months, charge stored batteries to a full charge.

Battery Replacement

The battery is expected to last for approximately 2000 recharge cycles.

NOTE: There are no serviceable parts inside the battery case. Do not open it.

IMPORTANT: Replace the battery only with an Omron Adept Technologies, Inc.
battery.

Dispose of the battery according to all local and national environmental regulations regarding
electronic components. Contact your local Omron support

CAUTION: PROPERTY DAMAGE RISK
Follow appropriate ESD procedures during the removal/replacement phases.

Removal

WARNING: PERSONAL INJURY RISK
The battery is heavy (19 kg/42 lbs). Observe safe lifting practices when remov-
ing or installing the battery.

1. Remove the inner rear platform cover.
a. Pull the bottom of the cover away from the platform chassis.
This is easiest if you grip it with two hands, toward the center.

b. Lower the cover down, so its top tab clears the rear outer cover.

2. Unlatch and open the battery compartment door, at the back of the platform.

The battery compartment door is capable of being locked. You may need to unlock it
before opening.

3. Disconnect the power and data cables before removing the battery.

See the following figure.
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Figure 10-12. Battery Cable Connectors

4. Slide the battery back and out of the platform.
There is a hand grip at the front and the rear of the battery, to help you lift it.

Installation

Refer to Installing the Battery on page 45 for instructions on installing the battery.

10.9 Replacing Non-Periodic Parts

All of the following parts are replaced on an as-needed basis.

Docking Station Roller and Bearing

WARNING: ELECTROCUTION RISK

There are no user-serviceable parts inside the docking station. Do not remove
the covers of the docking station. There is high voltage inside, and the covers
are not interlocked.

The roller, which guides the platform onto the docking station, may be subject to wear after
extended use. The time to replace the roller should be based on your visual inspection and
judgment of when it is too worn. We do not specify a quantitative measure for this.

Refer to the following figure for the location of the roller.
WARNING: ELECTROCUTION RISK

Unplug power from the docking station before starting. Remove the power cord
at the docking station.
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The roller is held to the docking station with a shoulder bolt.

1. Remove the shoulder bolt from the center of the roller. Retain the shoulder bolt.
2. Remove the roller and bearing from the docking station.

3. Install the new roller and bearing, using the retained shoulder bolt.

Figure 10-13. (A) Docking Station Roller, and (B) Switch

Docking Station AC Power Fuse

NOTE: The current version of the docking station uses a thermal fuse, built into
the power switch. There are no user-serviceable fuses.

NOTE: The following procedure applies only to legacy docking stations.
The only user-serviceable fuses are in the docking station. The two external AC fuses are loc-
ated between the power switch and the AC power plug.
Symptoms: When the docking station is switched on, the blue power light does not come on.
(Verify that the unit is plugged into AC power.)

WARNING: ELECTROCUTION RISK
Unplug power from the docking station before starting. Remove the power cord
from the charger.

Remove the fuse assembly by squeezing the two tabs toward each other, and pulling it away
from the docking station. See the following figure.
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Figure 10-14. Docking Station Fuse

The fuses are available from the factory as P/N 02212-000L. Equivalent fuses are available gen-
erically. The fuses need to be 250 V, 10 A, and Time-lag. An example of a fuse that meets this
is:

LittelFuse 0215010.XP, 5x20 mm cartridge type

Docking Station Internal Fuse

NOTE: The following procedure applies only to legacy docking sta-
tions. There are no user-serviceable fuses on the current docking sta-
tion.

Symptoms: When the docking station is switched on, the blue power light does
not come on, but the docking station can charge a battery manually.

WARNING: ELECTROCUTION RISK

Unplug power from the docking station before starting. The dock-
ing station cover is NOT interlocked. Remove the power cord at
the charger.

1. Remove the ten screws from the back cover of the docking station.

Two of these are on the sides, near the bottom.
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Figure 10-15. Docking Station Rear Cover Screws (8 of 10)

Retain the screws for reassembly.

2. Remove the rear cover of the docking station.

3. Locate the in-line fuse.

It will be near the top of the docking station, just to the right of the central
terminal bar.

4. Remove the old fuse, and replace it with a new fuse.
The fuse is P/N 13091-000.

5. Reinstall the docking station rear cover, and secure with the ten screws
previously removed.

Safety Scanning Laser

If the Safety Scanning Laser needs to be replaced, contact your local Omron support.

Obstacle Detection and Coupling Lasers

All of the lasers on the LD Platform Cart Transporter, other than the Safety Scanning Laser, are
the same model laser. The front of these lasers have two LEDs. Green indicates ready status,
flashing red indicates an error. No LEDs lit indicates no power.

These lasers come with an attached cable, about 0.3 m (12 inches) long, with a male M12 con-
nector.
Rear Sonar Units

The platform's four rear sonar units can be replaced individually. All four sonar units are
identical, although two are used as emitters and two as receivers, in pairs.
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1. Remove the inner and outer rear covers from the platform. Refer to Removing and
Installing LD Platform Cart Transporter Covers on page 158.

2. Unscrew the connection between the sonar cable and the sonar unit's lead.
Ensure that both the connectors and leads are labeled, and match. If not, label them.
3. Compress the two flat springs holding the sonar unit, and remove it from the cover.
Press the new sonar unit through the hole in the rear outer cover, from the outside.

4. Connect the sonar cable to the new sonar unit's lead.
5. Insert the new sonar unit through the hole in the rear outer cover.

6. Reinstall the rear covers.

Sonar Controller

The sonar controller is located in the payload bay.

Fiqure 10-16. (A) Sonar Controller, (B) Core

1. Move the payload structure out of the way, so you have access to the payload bay.

2. Locate the sonar controller.

The controller is at the front of the payload bay, screwed into the payload bay deck with
two screws, and is plugged into the Sonar 1 connector on the core. This connector is not
accessible from the payload bay, but does not need to be unplugged for this procedure.

3. Unscrew the controller from the payload bay deck by removing two screws.
Retain the screws for mounting the replacement controller.

4. Unplug the larger cable from the sonar controller.
Be careful not to let the cable end slip into the chassis.

5. Unplug the four sonar unit cables from the controller.
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These are the smaller cables that go to the individual sonar units. Make sure these are
labeled and tied up, so they can't slip into the chassis.

6. Connect the four sonar unit cables to the new controller.
Ensure that the cable labels match the controller labels.

7. Plug the larger cable into the new controller.

8. Screw the new controller to the payload bay deck, using the two screws removed from
the old controller.

9. Reinstall the payload structure.

10. Dispose of the old controller according to local and national regulations concerning elec-
tronic components.

Cart Latching Mechanism

CAUTION: PROPERTY DAMAGE RISK
The latch mechanism belt adjustment is for Omron Adept Technologies, Inc.
Field Service only. Changing the belt tension can lead to premature failure.

The acetal end of the Latching Mechanism is subject to wear, and may need replacement.

When the acetal on the cart Latching Mechanism has worn through a quarter of its original
thickness, or when either of the two screws holding the acetal block in place becomes flush
with the acetal block, the block needs to be replaced.

®

Figure 10-17. Cart Latch Mechanism with acetal block, Vertical Position

Callout Description Callout Description

A Latch Motor D Delrin Block
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B Belt

Cart Latch Hook

C Pulley

NOTE: The color of the acetal block may vary.

CAUTION: PINCH RISK

The latch of the LD Platform Cart Transporter can pinch you if you are not care-
ful. Keep your hands clear of the Latching Mechanism when it is in action.

WARNING: ENTANGLEMENT RISK
The belt and pulley of the LD Platform Cart Transporter can entangle your

hand during maintenance. Keep your hands clear of the belt and pulley when
they are moving. This is only a hazard during maintenance of this part of the

LD Platform Cart Transporter.
1. Remove the latching mechanism cover.

See Removing Latching Mechanism Cover on page 156.

2. Rotate the cart Latching Mechanism up on its pivot:

In order to replace the acetal block, the cart latch hook has to be rotated up to its vertical
position. If the hook-lowering block shown in the following figure is removed, the latch
hook will be pulled up to its vertical position.

o

Figure 10-18. Hook-lowering Block and Screws

Callout Description Callout Description
A Delrin Block C Hook-Lowering Block
B Hook D Screws

» Remove the two screws holding the hook-lowering block in place.

Retain the screws for re-assembly.

» Remove the block, allowing the latch hook to spring up.

Retain the block for re-assembly.

3. Unscrew the two screws holding the acetal block on the end of the latch hook.
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These were installed with threadlocker.
Retain these screws for attaching the replacement acetal block.

4. Remove the acetal block, and replace it with the new block.

5. Attach the new acetal block with the two screws previously removed.

Use Loctite® 222MS (blue) on the screws.

6. Reinstall the hook-lowering block.

o Manually lower the latch hook, and insert the block, which will keep the latch
hook in the down position.

o Insert the two screws previously removed to hold the hook-lowering block in
place.

7. Reinstall the latching mechanism cover.

See Installing Latching Mechanism Cover on page 158.

Light Discs

The two light disc assemblies and their controllers are single units, so replacing a controller
also replaces all of the lights on that side of the platform.

1. Remove the side cover, on the side that needs the light disc assembly replaced.
Refer to Removing and Installing LD Platform Cart Transporter Covers on page 158.
2. Unscrew the four screws holding the light disc PCA to the side cover.
Retain the screws and round cover for installing the new assembly.

3. Remove the light disc PCA.

4. Screw the new assembly and retained round cover to the side cover, using the screws
retained from the old assembly. The PCA is keyed so that it can only be installed in one
orientation.

5. Reinstall the side cover, connecting the cable to the new light disc PCA.
6. Dispose of the old light disc PCA according to local and national regulations con-
cerning electronic components.
Operator Panel

The Operator panel will typically be located on a user-supplied payload structure, so the
removal and replacement of this will vary from one AIV to another. It plugs into the HMI
Panel connector on the core.

Wheels and Tires

The wheels and tires should be checked every 3 months. If they show signs of cracking, excess-
ive wear, or any damage they should be replaced. Refer to the following figure.

14766-000 Rev G LD Platform Cart Transporter User's Guide 173



10.9 Replacing Non-Periodic Parts

Figure 10-19. Samples of Tire Wear

The wheels/tires are not user-serviceable parts. If the tires are worn or cracked, contact your
Omron sales representative.

Drive Assemblies
The platform drive assemblies have been designed to be field-replaceable. This will replace the
drive motor, gearbox, encoder, and wheel/tire assembly.

Removal

1. Remove the inner rear cover.

2. Unlatch and open the battery compartment door, at the back of the platform.

The battery compartment door is capable of being locked. You may need to unlock it
before opening.

3. Disconnect battery power by unplugging the two cables at the rear of the battery.

4. Remove the side cover a small distance from the platform on the side where you want
to replace the drive assembly. Refer to Removing and Installing LD Platform Cart Trans-
porter Covers on page 158.

The light disc PCA cable will still be attached.

5. Disconnect the cable from the light disc PCA, so the side cover can be moved com-
pletely away from the platform.

This will expose the drive assembly.
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Figure 10-20. LD Drive Assembly (arrow)

6. Lift the drive wheel up, compressing its springs, enough so that you can insert a @6 x
10 mm (0.24 x 0.4 inch) pin into the hole on the rear side of the assembly (there is a
hole on each side). This will keep the springs compressed (the wheel will be in the up
position), and make removal easier. An M5 x 10 screw works well for this. If you saved
the wheel pin, it should be used for this. See Figure 3-9. See also Chapter 10:

Figure 10-21. Spring-Compression Hole (arrow)
7. The drive assembly is held in place with three nuts on studs across the top, and two
pairs of screws at each side, near the bottom of the assembly.

Remove the three nuts and four screws (and their washers) holding the drive assembly
to the platform.

Retain these nuts, screws, and washers for attaching the new drive assembly.
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Figure 10-22. Mounting Studs and Nuts at top of Drive Assembly

Figure 10-23. Mounting Screws at Bottom-Right of Drive Assembly

8. Remove the drive assembly from the platform.
The motor cable to the LD Platform core will still be attached.

9. Disconnect the motor cable at the drive assembly.

Installation

1. Lift the new drive wheel up, compressing its springs, enough so that you can insert a 6
x 10 mm (0.24 x 0.4 inch) pin into the hole on the rear side of the assembly (there is a
hole on each side). This will keep the springs compressed (the wheel will be in the up
position), and make installation easier. If you saved a wheel pin when you uncrated the
platform, you can use that. An M5 x 10 screw also works well for this. See Maintenance
on page 145.

NOTE: Make sure that the pin is short enough so that you can pull it out
after the assembly is in place.

2. Connect the motor cable to the new drive assembly.

3. Install the new drive assembly over the three studs at the top of its bracket.
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Use the nuts, screws, and washers you removed from the old drive assembly.

4. Remove the pin or screw you used to hold the wheel in the up position.
5. Put the side cover next to the platform, and attach the cable to the light disc PCA.
6. Reinstall the side cover.

7. Connect the battery power and data cables, and close the battery compartment door.

®

Reinstall the rear cover.

Platform Casters

The platform casters should be checked every 3 months. If they show signs of cracking, excess-
ive wear, or any damage they should be replaced.

All four platform casters are identical, and are mounted to the platform in the same way.
NOTE: If you have a means of lifting the chassis of the platform enough to
access the screw that holds on the caster, you can avoid removing the battery,
which is only necessary to tilt the platform on its side.

If you cannot lift the chassis enough to access the caster screw:

1. Move the payload structure out of the way.

If the payload structure can be completely removed, do so. This enables you to tip the
AIV on its side, so you have access to the casters underneath.

2. Remove the inner rear cover.

3. Unlatch and open the battery compartment door, at the back of the platform.

The battery compartment door is capable of being locked. You may need to unlock it
before opening,.

4. Disconnect the battery by unplugging the two cables at the rear of the battery.
5. Remove the battery from the platform.
6. Remove the side covers.

7. Lay the body of the platform on its side, exposing the casters.

WARNING: MAGNETIC FIELD - MEDICAL IMPLANT RISK
Magnetic fields can be hazardous to medical implant wearers. Medical
implant wearers stay back 30 cm (12 inches) from the underside of the
platform, which is exposed during this maintenance procedure when
the platform is tipped on its side.

Whether or not you had to remove the battery:
1. Remove the M10 x 30 mm screw holding the caster to the platform.
The screw was installed with Loctite 263.

Retain the screw for attaching the new caster.
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Figure 10-24. Platform Caster Replacement

Callout Description

A (4) M6 x 22 Screw, Flat Head Socket

Caster, Heavy Duty, with Bolt Hole Fitting

M10 x 30 mm Screw, Flat Head Socket

Use Locktite 263 on the M10 x 30 Screw

o | OO | =

Completed Assembly

2. Remove the caster from the platform.

3. Put the new caster in place, and attach with the M10 x 30 mm screw you removed from
the old caster.

Use Loctite 263.
Torque to 27 N-m (20 ft-1bf).
If you removed the battery for this procedure:

1. Return the platform to its upright position.

2. Reinstall the battery, connect the power and data cables, and close the battery com-
partment door.

3. Reinstall the inner rear cover.

4. Reinstall the side covers.
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Cleaning Casters on ESD Platforms

Casters on the ESD platform are critical components as they provide the path to ground. As
such, they require regular, periodic cleaning to preserve ESD protection capability.

CAUTION: PERSONAL INJURY OR PROPERTY DAMAGE RISK
This procedure requires placing the platform on its side. Unless you can do
this safely with the payload attached, you will need to remove the payload.

You will need the following tools:

» Gloves

o Wipes

« Isopropyl Alcohol

» Protective, supporting material on which to rest the platform (e.g., foam)
1. Remove the payload structure, if necessary.
2. Remove the right and left side skins, and set them aside.

3. Lift and pin the drive assemblies to more easily maneuver the platform. This puts entire
robot weight on casters.

4. Place the protective, supporting material on the right side of the platform. Using the
right side prevents possible damage to the maintenance access panel.

5. Carefully tilt the platform onto its right side onto the protective, supporting material.
6. Use a wipe wetted with Isopropyl Alcohol to thoroughly clean the casters.
7. After cleaning all casters, carefully tilt the platform upright.
8. Un-pin and lower the drive assemblies.
9. Re-install the payload structure if it was removed.
10. Re-install the two side skins you removed earlier.

11. Clean the side skins if needed.

LD Platform Cart Transporter Casters

The cart casters should be checked every 3 months. If they show signs of cracking, excessive
wear, or any damage they should be replaced.

Front Caster Removal

The two front casters are identical, and are mounted to the transporter in the same way.
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Figure 10-25. Front Cart Caster Screw Assembly

Remove the M10 screw and washer holding the caster to the cart.
Threadlocker was used on this screw during assembly.
Retain the screw, washer, and lock washer for mounting the new caster.

Remove the caster from the cart.

Front Caster Installation

1.

Put the new caster in place, and attach with the M10 screw and washers you removed
from the old caster.

Use Loctite 263 on the screw.
Torque to 73.2 N-m (54 ft-1bf).

Rear Caster Removal

The two rear casters are the same as each other, but different from the front casters, due to the
fact that the rear casters have brakes.

1.

2.

180

Remove the top plate of the cart. See Removing Top Plate on page 156.
Unscrew the lock nut from the axle screw going through the caster wheel.

Remove the axle and caster wheel.

The axle screw, lock nut, and caster wheel can be discarded.
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4. Loosen the outer brake-adjust jam nut at the actuator bar for the caster you are repla-
cing.

See Figure 10-27.
Lift the cable and brake-adjust assembly out of the slot in the actuator bar.

5. Push the inner wire into the brake cable housing until the brake pin, which presses
against the caster wheel surface, slides out of the caster mounting screw.

Figure 10-26. Brake Pin

Callout Description Callout Description
A Shaft of pin slides inside C Flat top of blunt end retains
caster mounting screw spring
B Blunt end passes against D Brake cable wire, with ball
caster wheel end, fits into slot and hole

6. Remove the brake pin with spring from the inner brake cable wire.
Save the brake pin and spring for reassembly.

7. Pull the brake cable inner wire up far enough to be out of the way for removing the
caster mounting screw.

8. Unscrew the caster mounting screw, to remove the caster assembly from the cart body.

Retain the caster mounting screw and lock washer for mounting the new caster.
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Rear Caster Installation

1.

Unscrew the lock nut from the axle going through the new caster wheel.
Retain the lock nut for reassembly.

Remove the axle and caster wheel from the caster. Do not discard.
Retain the axle and caster wheel for reassembly.

Attach the caster body to the cart body using the caster mounting screw and lock
washer previously removed.

Take care not to damage the brake cable inner wire.
NOTE: Do not use threadlocker on the rear caster mounting screws.

Torque to 73.2 N'm (54 ft-1bf).

Push the brake cable inner wire back into the cable housing, so the ball end slides out of
the caster mounting screw.

Make sure the spring, previously removed from the brake pin, is in place on the brake
pin. The wide end goes up, against the caster mounting screw.

Insert the ball end of the inner wire into the hole in the brake pin, with the inner wire in
the slot above the hole.

Slide the brake pin up inside the caster mounting screw, and hold it in place for the
next step.

Install the caster wheel into the caster frame with the axle screw.

Fasten with the lock nut, previously removed.

Torque the lock nut to 41 N-m (30 ft-Ibf). Ensure that the wheel spins freely.

The wheel will hold the brake pin inside the caster mounting screw, so it can’t fall out.

Pull the inner wire of the cable through the actuator bar, and lock in place with the jam
nut previously removed. Use Loctite 242 on the jam nut.

Cart Brake Release

Refer to the following figure for replacement and adjustment.

The Cart Brake Release consists of the lever cable with handle, and the caster brake system.
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Fiqure 10-27. Internal Brake-Release Mechanism

Callout Description Callout Description
A Right Brake Cable F Actuator Bar
B Right Brake Adjust G Actuator Bar Hard Stop
C Lever Cable H Left Brake Cable
D Pulley I Left Brake Adjust
E Lever Cable Anchor K Lever Cable Clamp

Replacing Brake Lever Cable
To replace the cart brake-release cable:

1. Remove the cart top plate. See Removing Top Plate on page 156.

2. Disconnect the end of the cable from the brake control mechanism.
a. Disconnect the inner wire from the lever cable clamp.
b. Disconnect the lever cable from the lever cable anchor.

3. Feed the lever cable out through the hole in the horizontal back bar of the cart.

You will need to cut the cable tie at the saddle.
4. Disconnect the brake-release lever from its mounting place.

This will vary, depending on how and where you mounted it.

Adjusting the Lever Cable

The brake lever cable needs to be adjusted so there is no excess slack, but so the brakes are
engaged when the lever is not being actuated.

14766-000 Rev G LD Platform Cart Transporter User's Guide 183



10.9 Replacing Non-Periodic Parts

The brake lever cable should be adjusted at the lever cable clamp, shown in the prededing fig-
ure. There should be just enough slack so the actuator bar touches its hard stop.
Adjusting the Caster Brake Cables

The two caster brake cables are adjusted at the factory. They will normally not need to be adjus-
ted by the user.

If any adjustment is needed, refer to the preceding figure for the adjustment location. The brake
pins should be able to go down as far as the caster surface allows, without any slack.

After the caster cables are adjusted correctly, ensure that the actuator bar just touches its hard
stop. This will keep the actuator bar in position if you have to adjust the lever cable.

LD Platform Core

The LD Platform core is an enclosed unit, with internal fans as the only moving parts.

1. Access the payload bay. Refer to Accessing the Payload Bay on page 156.
2. Remove the inner rear cover.

3. Unlatch and open the battery compartment door, at the rear of the platform.
The battery compartment door is capable of being locked. You may need to unlock it.

4. Disconnect the battery power and data cables from the rear of the battery.

5. Disconnect all of the cables that are attached to the top portion of the LD Platform core.
Refer to Standard Platform Connections on page 89.
6. Remove the core mounting bracket from around the LD Platform core.

This is two pieces, held in place with four screws down into the chassis, with four more
going sideways into the LD Platform core itself. Retain all of these screws for installing
the new LD Platform core.

See the following figure:

Figure 10-28. Core Mounting Bracket
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Remove the Sonar 1 cable from the core.
This cable is too short to allow the core to be lifted, until the cable is removed.

Gently lift the LD Platform core up, until you have access to the internal connections.

Remove all of the cables that are attached to the internal LD Platform core connector
panel.

The Left Motor and Right Motor connectors use the same type of plug, and can be inad-
vertently reversed. Ensure that you can identify the left from the right.

See Internal LD Platform Core Connections on page 105.

Remove the old LD Platform core.

Connect all of the cables that were attached to the internal LD Platform core connector
panel to the new core internal connector panel. See Figure 6-12.

Wait until after the next step to reconnect the Sonar 1 cable.

Put the core into the chassis.
Connect the Sonar 1 cable to the core.

Install the core mounting brackets around the new LD Platform core.

Using the screws and washers you removed from the old core, put four screws into the
sides of the LD Platform core, with four more going down into the platform chassis.

Reconnect all of the cables to the top portion of the LD Platform core.
Refer to Standard Platform Connections on page 89.

Reconnect the battery power and data cables to the battery.
Close and latch the battery compartment door.
Reinstall the inner rear cover.

Reinstall the platform top plate and Latching Mechanism cover.
Refer to Accessing the Payload Bay on page 156.

Dispose of the old core according to local and national regulations concerning electronic
components.

E-Stop and Safety Laser Commissioning

Under normal circumstances, the AIV is commissioned at the factory, and will not need to be
re-commissioned. However, you must redo the E-Stop Commissioning and the Safety Laser
Commissioning procedures under the following circumstances:

o If the core gets replaced, it will be necessary to redo the E-Stop Commissioning and the

Safety Laser Commissioning procedures.

o If the hardware detects a failure, the AIV may automatically decommission itself, and

the AIV will have to be re-commissioned to recover. In this event, ARAM will display a
fault popup in MobilePlanner.

 If you are using a user-supplied E-Stop.
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o Some customers have expressed a desire to perform the commissioning procedures on a
regular basis as part of their preventive maintenance process.

NOTE: After performing either of these tests, you can access the other test by
clicking Next Test on the final screen.

E-Stop Commissioning

This procedure verifies that the E-Stop circuitry is triggered when the E-Stop button is pressed.
This is verified by ensuring that you hear the brakes activate after pressing the E-Stop button.

1. Ensure that the E-Stop button is NOT depressed before starting.

2. From the MobilePlanner software, select:
Main Menu > Robot > Safety Commissioning

3. Follow the on-screen instructions to complete the test. You can print a certificate after
successful completion of the commissioning,.

Safety Laser Commissioning

This procedure verifies that the safety scanning laser reports speed zone information correctly,
and that the E-Stop circuitry is tripped when an obstacle that should be detected by the laser is
placed in front of the AIV. The speed zones are listed in the following table. (When you press
the Drive button in the wizard, the wizard will display the maximum AIV speed.)

Maximum Speed (mm/s)
Zone | LD-105CT LD-130CT
0 225 150
1 450 300
2 675 450
3 900 600
4 1125 750
5 1350 900
6 1350 900
7 1350 900

1. From the MobilePlanner software, select:
Main Menu > Robot > Safety Commissioning

2. Follow the on-screen instructions to complete the test. You can print a certificate after
successful completion of the commissioning.
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11.1 Dimension Drawings
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Figure 11-2. Coupling Plate Dimensions, Arms Removed, (A) Through hole (units are mm)
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Fiqure 11-1. Overall LD Platform Cart Transporter Dimensions (units are mm)
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Fiqure 11-3. Cart Dimensions, (A) Threads (units in mm)

If you have a factory-supplied cart, these preceding dimensions show where you will attach

your payload.

11.2 Specifications

LD Platform Cart Transporter Physical

Description Specification
Physical
Overall Length (with HMI post) 894 mm
Width (at side lasers) 1073 mm
Height (body) 383 mm
Overall Height (with HMI post) 1393 mm
Weight (with battery) 81 kg (179 Ib)
Body clearance 50 mm
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Description

Specification

Rating

IP Rating

IP20

Cleanroom rating

Fed Class 100, ISO Class 5

Suspension

Drive wheels

2 grey non-marking foam-filled rubber

Wheel diameter

200 x 50 mm nominal

Brakes

2 (one each axle)

Steering

Differential

Passive Casters

2 front, 2 rear, spring-loaded

Caster diameter

75 mm nominal

LD Platform Cart Transporter Performance

Description

Specification

Performance

Max payload LD-105CT: 105 kg (231 Ib)
LD-130CT: 130 kg (287 Ib)

Run-time 15 h continuous, approx.

Swing radius

Platform or Platform and Cart:
698.5 mm

Turn radius

0mm

Translational speed, max

LD-105CT: 1350 mm/s (53.1 inches/s)
LD-130CT: 900 mm/s (35.4 inches/s)

Traversable step

5 mm with cart, 130 kg

Traversable gap

5 mm with cart, 130 kg

CAUTION: PROPERTY DAMAGE RISK

ponents.

The LD Platform Cart Transporter with a cart is capable of driving
overagaporstepof 5 mm (0.2 inch) at a speed of 250 mm/s, but
this should not be regarded as normal use. Regular driving over
such gaps or steps will shorten the lifespan of the drivetrain com-

Minimum floor flatness

Fg25 (based on the ACI 117 standard)

NOTE: ACI 117 is the American Concrete Institute’s standard for
concrete floors. Fg is flatness, F_is the level. Higher Fg numbers
represent flatter floors. Fg 25 is a fairly lenient specification.

14766-000 Rev G
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Description

Specification

Battery

Run-time 15 hours, approx., no payload
Duty cycle 80%

Weight 19 kg (42 Ib)

Voltage 22-30VDC

Capacity 72 Ah

Energy 1.84 kWh nominal

Recharge time

4 h, approx.

Life span

Approximately 2000 Cycles

Sensors

Safety Scanning Laser

1 at front of platform, 200 mm (7.9 inches)
height

240°, 15 m range, Class 1, eye-safe

PLd Safety per ISO-13849

Side Lasers

2 on horizontal tubes of HMI post
270°,4 m range, Class 1, eye-safe

Low Level Laser

1 at front of platform, in bumper
270°,4 m range, Class 1, eye-safe

Coupling Laser

1 on platform deck, passing through the top
plate into the coupling plate
270°,4 mrange, Class 1, eye-safe

Rear-facing laser

1 on HMI post
270°,4 mrange, Class 1, eye-safe

Sonar 2 pairs at rear of platform, 2 m range
(Each pair is one emitter and one

receiver)

Bumper 1 at front of platform, triggers 4 sensors

Position encoders

2 encoders (one each wheel)

2 Hall sensors (one each wheel)

Analog gyroscope (core)

320°/s max rotation

Acuity localization (option)

1 camera on HMI post Operator Panel

Battery Output

. Maximum . .-
Nominal Qty Actual Current Description
5VvDC 1 5+5% VDC 1A Switched Aux power
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Nominal Qty Actual Mg::_':::: Description
12 vDC 1 12+5% VDC 1A Switched Aux power
20 VvDC 1 20+5% VDC 1A Switched Aux power
22 -30VDC 2 battery 4 A Switched
22 -30VDC 1* battery 10A Switched
22 -30VDC 1* battery 10A Safe, Switched
* 10 A Switched and 10 A Safe, Switched share the 10 A of current.

Cart

Description

Specification

Physical

Length 592 mm
Width 846 mm
Height 480 mm
Weight 23 kg (50 Ib)
Rating

Caster ESD ESD rated

Suspension

Passive Casters

2 front, 2 rear, spring-loaded

Caster diameter

100 mm (4 inches) nominal

Caster Brakes

2 rear casters

Docking Station

Description

Specification

rating (SCCR)

Current 8 A, thermal fuse built into power switch
Contacts 2

Voltage 100-240 VAC, 50/60 Hz

Power consumption | 800 W

Short circuit current | 1500 A

Humidity

5% to 95% non-condensing

Temperature

5t040°C (41 to 104°F)

Dimensions - WxDxH

349 x369x315mm

LD Platform Cart Transporter User's Guide
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Description

Specification

with Floor plate

495 x495.5x317 mm

Weight 8.2 kg (18 1b)

Mounting Directly to floor, wall bracket (included), or on floor
(free-standing) with included floor plate

Indicators Power on - blue
Charging - yellow

Connector For out-of-platform battery charging
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